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Introduction

This manual serves as a guide for technical personnel conducting
GeneChip® Mapping 100K experiments in the laboratory. It contains
protocols for sample preparation, array hybridization, information for
washing, staining, and scanning arrays and generating genotype
calls. It also includes extensive troubleshooting information. This
technical manual is divided into chapters which describe in detail
specific aspects of the GeneChip Mapping 100K Assay. A description
of each chapter follows.
Chapter 1: Scientific Overview. A description of the overall concept
behind the GeneChip Mapping assay, including the biochemical process,
data generation, potential applications, and a list of references.
Chapter 2: Laboratory Setup. An explanation of the appropriate
laboratory configuration for running GeneChip Mapping 100K experiments
including how to set up a workflow to minimize the possibility of carryover
contamination.
Chapter 3: Genomic DNA Preparation. The requirements for genomic
DNA, with recommended sources and methods for purification and
quantitation.
Chapters 4: Experimental Protocols. Detailed, step-by-step protocols for
preparation of sample from genomic DNA, including restriction digestion,
adaptor ligation, amplification, purification, quantitation, fragmentation,
labeling and array hybridization. A description of quality control
checkpoints included at various stages of the protocol which enable array
performance to be monitored.
Chapter 5: Washing, Staining, and Scanning. Basic protocols for fluidics
station and scanner operation.

i

ii

Chapter 6: Fluidics Station Maintenance Procedures. Describes a weekly
fluidics station bleach protocol and a monthly fluidics station
decontamination protocol.
Chapter 7: Analysis Workflow and Guidelines for Assessing Sample and
Data Quality. Describes the analysis workflow in GCOS and GDAS, and
provides information for assessing data quality.
Chapter 8: Troubleshooting. Additional guidelines for obtaining optimal
assay results including troubleshooting tips.
Chapter 9: Reagents, Instruments, and Supplies. A complete list of the
reagents required for the GeneChip Mapping Assay including those
provided in the assay kit and recommended suppliers of supplementary
items.
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Chapter 1

Scientific Overview

The discovery of millions of single-nucleotide polymorphisms (SNPs) in the
human genome has been received by the scientific community with great
enthusiasm. This large repository of markers for human variation allows
innovations in genotyping technologies and construction of increasingly
dense SNP maps and other tools. These tools have the potential of enabling
investigators to map complex human genetic traits, to understand the history
of human populations, and to examine chromosomal copy number changes
that lead to cancer and other diseases, all at unprecedented resolution.
One such tool is the Affymetrix GeneChip® Mapping 100K Set, which can
genotype more than 100,000 SNPs on two arrays, using a single polymerase
chain reaction (PCR) primer. As its name implies, it is a mapping tool
designed to identify regions of the genome linked to or associated with a
particular trait or phenotype. Additionally, it is useful for determination of
allele frequencies in various populations and for mapping regions with loss
of heterozygosity during cancer progression.
Currently, millions of common human SNPs have been identified (The
International HapMap Consortium, 2003, Sachidanandam, et al. 2001).
The large numbers of SNPs available will allow for higher-density, genomewide mapping sets, which in turn will increase the amount of information
that can be extracted for linkage and association studies. Additionally, a
higher density of SNPs increases the proportion of linkage disequilibrium
(LD) measured in the sample. While detailed LD information will soon
become available for major population groups as a result of the HAPMAP
project (The International HapMap Consortium, 2003, Sachidanandam,
et al. 2001), there will also be a need to map and measure blocks of LD in
isolated populations. Hundreds of thousands of SNPs are predicted to be
necessary to capture LD for mapping complex diseases. In studies of cancer
where there is chromosomal instability, denser sets of markers will allow
finer resolution in determining the borders of chromosomal losses and gains.
These and other studies will benefit as denser SNP marker sets become
available.
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The challenge faced by researchers today is that the scoring of these SNPs
by currently available methods is labor intensive and requires a substantial
level of automation. While a variety of robust genotyping technologies do
exist for scoring SNPs, most require 2-6 oligonucleotides to amplify the
locus and to discriminate alleles. Clearly such methods are costly and
difficult to scale to > 100,000 SNPs.
The GeneChip Mapping Assay eliminates these bottlenecks because the
assay does not require robots or automation. Instead, the GeneChip Mapping
Assay takes advantage of GeneChip brand microarrays by coupling a highly
reproducible generic sample preparation method with allele-specific
hybridization (Kennedy, et al. 2003; Matsuzaki, et al. 2004). Whole genome
sampling analysis (WGSA) is a highly-scalable method for genotyping
SNPs on synthetic oligonucleotide arrays. This method was used initially to
develop one primer 10,000 SNP assay (Mapping 10K) and has now been
scaled to genotype > 100,000 SNPs on two arrays (GeneChip® Human
Mapping 50K Array Xba 240 and the GeneChip® Human Mapping 50K
Array Hind 240).
This genotyping approach satisfies three important criteria. First, sample
preparation avoids the use of individual SNP-specific primers. Second, the
reduction and amplification is highly reproducible, capturing a majority of
the same SNPs across many samples. Finally, the method produces highly
accurate genotype calls (Matsuzaki, et al. 2004, Middleton, et al. 2004).
The GeneChip Mapping Assay is outlined in Figure 1.1. After in silico
prediction of SNPs residing in desired genomic fractions, oligonucleotides
corresponding to these SNP-containing fragments were used to design highdensity microarrays. Following biochemical fractionation that mirrors the
in silico fractionation, the target is hybridized to arrays and SNPs are
genotyped by allele-specific hybridization.

GeneChip® Mapping 100K Assay Manual

In silico fractionation

Synthesis of predicted fragments on microarrays

Biochemical fractionation

Allele specific hybridization and Genotype Calling
Figure 1.1
GeneChip Mapping Assay Strategy

Figure 1.2
GeneChip Mapping Assay - Xba I
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Figure 1.3
GeneChip Mapping Assay - Hind III
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Chapter 2

Laboratory Setup

Please read this chapter before planning any experiments.

The GeneChip® Mapping 100K Set has been optimized to reliably and
accurately detect greater than 100,000 SNPs in each sample. The assay
reduces the complexity of the genome by preferentially amplifying 2502000 basepair (bp) Xba I fragments and 250-2000 bp Hind III fragments
using a single PCR primer from only 250 ng DNA per restriction enzyme.
As with all genotyping applications, care should be taken to minimize
possible sources of contamination that would reduce genotyping accuracy,
call rate, and consequently, genetic power.
To reduce the possibility of cross-contamination, Affymetrix recommends
maintaining a single direction workflow.
The 50K Hind assay and the 50K Xba assay should be preformed separately
(different days or morning/afternoon) to avoid sample mix up with the
wrong components.
The most likely potential source of contamination for the GeneChip
Mapping Assay is previously amplified PCR product.

Steps should be taken to minimize the possibility of contaminating pre-PCR
steps with amplified PCR product. Suggested precautions include:
■

Store reagents in proper room according to the box label and manual
instructions.

■

Restrict movements through labs containing amplified DNA.

■

Use proper gowning procedures.

■

Use dedicated equipment (e.g., pipets, tips, thermocyclers, etc.) for prePCR stages.

■

Print separate copies of the protocol for each room.

In addition, the following areas should be used when performing this assay:
pre-PCR Clean Room, PCR Staging Room, and Main Lab.
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Pre-PCR Clean Room

Once a high copy area has been entered, a low copy area should not be
entered until the researcher has showered and changed into freshly
laundered clothing.

A summary of the areas is shown in Figure 2.1.

Pre-PCR Clean Room
The Pre-PCR Clean Room (or dedicated area such as a biosafety hood)
should be free of DNA template and PCR amplicons. The master stocks of
PCR primer and adapter should be stored here, with aliquots taken for use in
the PCR Staging Room (or area). Reagent preparation tasks, such as
preparing Master Mixes, should be done in this room. The use of gowns,
booties, and gloves is strongly recommended to prevent PCR carryover and
will minimize the risk of trace levels of contaminants being brought into the
Pre-PCR Clean Area. This room should contain dedicated pipets, tips,
vortex, etc.

PCR Staging Room
The PCR Staging Room (or Area) is a low copy template lab which should
be free from any PCR product (amplicons). It is the area where nonamplified template (genomic DNA) should be handled. The digestion and
ligation reactions should be conducted in this area. The PCR reactions
should be prepared in this area. The use of gowns, booties, and gloves is
recommended to prevent PCR carryover.
Each room should contain dedicated equipment such as thermocyclers,
microfuges, pipets, tips, etc.

Main Lab
The Main Lab has airborne contamination with PCR product and template.
After entering the main lab it is inadvisable to re-enter the Pre-PCR Clean
Area or the PCR Staging Area without first showering and changing into
freshly laundered clothes.
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Template (Genomic DNA)

Pre-PCR Clean Room
Assay Steps:
Step 1: Reagent Preparation

PCR Staging Room
Assay Steps:
Step 2: Enzyme Digestion
Step 3: Ligation
Step 4: PCR (set up only)

Main Lab
Assay Steps:
Step 4: PCR Thermal Cycling
Step 5: PCR Clean up
Step 6: Fragmentation
Step 7: Labeling
Step 8: Hybridization
Step 9: Wash and Stain
Figure 2.1
A summary of rooms required to perform the GeneChip® Mapping Assay.

PCR Product
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Safety Precautions

Safety Precautions
The GeneChip® Mapping 50K Assay Kits as well as the GeneChip Human
Mapping 50K Array Xba 240 and the GeneChip Human Mapping 50K
Array Hind 240 are for research use only.
All blood and other potentially infectious materials should be handled as if
capable of transmitting infection and disposed of with proper precautions in
accordance with federal, state, and local regulations.
Some components required for this assay may pose significant health
risks. Follow prudent laboratory practices when handling and disposing
of carcinogens and toxics. Refer to the manufacturer’s Material Safety
Data Sheet for additional information.

Wear appropriate personal protective equipment when performing this assay.
At a minimum, safety glasses and chemical resistant gloves should be worn.
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Chapter 3

Genomic DNA Preparation

This chapter describes the general requirements for genomic DNA
sources and extraction methods. A genomic DNA control (Reference
Genomic DNA, 103) is provided in the GeneChip® Mapping 50K Xba
Assay Kit and the GeneChip® Mapping 50K Hind Assay Kit. This
control DNA meets the requirements outlined below and should be
used as a routine experimental positive control and for
troubleshooting. Assay performance may vary for genomic DNA
samples that do not meet the general requirements outlined below;
however, the reliability of any given result should be assessed in the
context of overall experimental design and goals.
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General Requirements for Human Genomic DNA

General Requirements for
Human Genomic DNA
1.

DNA must be double-stranded (not single-stranded). This
requirement relates to the restriction enzyme digestion step in the
protocol.

2.

DNA must be free of PCR inhibitors. Examples of inhibitors include
high concentrations of heme (from blood) and high concentrations of
chelating agents (i.e., EDTA). The genomic DNA extraction/
purification method should render DNA that is generally salt-free
because high concentrations of certain salts can also inhibit PCR and
other enzyme reactions. DNA should be prepared as described in
Chapter 4, GeneChip® Mapping Assay Protocol.

3.

DNA must not be contaminated with other human genomic DNA
sources, or with genomic DNA from other organisms. PCR
amplification of the ligated genomic DNA is not human specific, so
sufficient quantities of non-human DNA may also be amplified and
could potentially result in compromised genotype calls. Contaminated
or mixed DNA may manifest as high detection rates and low call rates
(see Contaminated Genomic DNA on page 109).

4.

DNA must not be highly degraded. For any particular SNP, the
genomic DNA fragment containing the SNP must have Xba I (or
Hind III) restriction sites intact so that ligation can occur on both ends
of the fragment and PCR can be successful. The approximate average
size of genomic DNA may be assessed on a 1% agarose gel using an
appropriate size standard control. High quality genomic DNA will run
as a major band at approximately 10-20 kb on the gel; assay
performance may vary with DNA that is substantially more degraded.

5.

Genomic DNA that has been pre-amplified (i.e., PEP) or pre-digested
with other restriction enzymes (other than Xba I or Hind III) have not
been tested by Affymetrix with this assay. Customer feedback suggests
that certain methods (e.g., Phi 29) (Paez, et al. 2004) may give
reasonable results, whereas other methods (e.g., PEP) do not. You
should plan your own experiments to evaluate pre-amplification with
this assay.
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Sources of Human
Genomic DNA
The following sources of human genomic DNA have been successfully
tested in the laboratories at Affymetrix for DNA that meets the requirements
described in the section General Requirements for Human Genomic DNA on
page 20.
■

blood

■

cell line

Success with other types of samples such as formalin fixed paraffinembedded tissue will depend on quality (degree of degradation, degree of
inhibitors present, etc.), quantity of genomic DNA extracted, and purity of
these types of samples, as described in the section General Requirements for
Human Genomic DNA on page 20.

Genomic DNA Extraction /
Purification Methods
Genomic DNA extraction and purification methods that meet the general
requirements for genomic DNA outlined above should yield successful
results. Methods that include boiling or strong denaturants are not
acceptable, because the DNA would be rendered single-stranded. Genomic
DNA extracted using the following methods have been tested in the
laboratories at Affymetrix:
1.

SDS/ProK digestion, phenol-chloroform extraction, Microcon® or
Centricon® (Millipore®) ultrapurification and concentration.

2.

QIAGEN; QIAamp DNA Blood Maxi Kit.
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DNA Cleanup

DNA Cleanup
If you suspect your genomic DNA preparation has inhibitors, you may wish
to use the following procedure for cleanup.
1.

Add 0.5 volumes of 7.5 M NH4OAc, 2.5 volumes of absolute ethanol
(stored at -20°C), and 0.5 µL of glycogen (5 mg/mL) to 250 ng genomic
DNA.

2.

Vortex and incubate at -20°C for 1 hour.

3.

Centrifuge at 12,000 x g in a microcentrifuge at room temperature for
20 minutes.

4.

Remove supernatant and wash pellet with 0.5 mL of 80% ethanol.

5.

Centrifuge at 12,000 x g at room temperature for 5 minutes.

6.

Remove the 80% ethanol and repeat the 80% ethanol wash one more
time.

7.

Re-suspend the pellet in TE (10 mM Tris, pH 8.0, 0.1mM EDTA,
pH 8.0).
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Chapter 4

GeneChip® Mapping Assay Protocol

Introduction
The Affymetrix GeneChip® Mapping Assay, in conjunction with the
GeneChip Human Mapping 100K Set, is designed to detect > 100,000
Single Nucleotide Polymorphisms (SNPs) in samples of genomic DNA. The
Mapping 100K Set is comprised of two arrays and two assay kits. Each array
and its corresponding assay kit are processed independently from the second
enzyme. The protocol starts with 250 ng of genomic DNA per array and will
generate SNP genotype calls for more than 50,000 SNPs for each array of a
two array set. An overview of the assay is shown in Figure 4.1. The assay
utilizes a strategy that reduces the complexity of human genomic DNA up to
10 fold by first digesting the genomic DNA with the Xba I or Hind III
restriction enzyme and then ligating sequences onto the DNA fragments.
The complexity is further reduced by a PCR procedure optimized for
fragments of a specified size range. Following these steps the PCR products
(amplicons) are fragmented, end-labeled, and hybridized to a GeneChip
array.
Arrays from different enzyme fractions should not be processed by the
same technician on the same day.
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Introduction

Assay Overview

Xba I

Hind III

Genomic DNA

Genomic DNA

Xba I Digestion

(2.5 hrs)

Hind III Digestion

Ligation

(2.5 hrs)
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Dilution
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PCR PCR PCR

(2.5 hrs)

PCR PCR PCR

Purify
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(0.75 hr)
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(2.25 hrs)
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(16 hrs)
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Washing & Staining

(2 hrs)

Washing & Staining

Scanning
Figure 4.1
GeneChip® Mapping 50K Assay Overview

Scanning
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Genomic DNA Preparation
Preparation of Genomic DNA

The concentration of the genomic DNA should be determined and the
working stocks diluted to 50 ng/µL using reduced EDTA TE buffer (0.1 mM
EDTA, 10 mM Tris HCl, pH 8.0).
An elevated EDTA level is not recommended as it may interfere with
subsequent reactions.

For high throughput assays, aliquot 5 µL (50 ng/µL) of each diluted genomic
DNA into each well of a 96-well plate. Make multiple replicates of the plates
if needed.
Reagents
■

Reduced EDTA TE Buffer (10 mM Tris HCl, pH 8.0, 0.1mM EDTA, pH 8.0)
TEKnova P/N T0223

STEP 1: Reagent
Preparation and Storage
The reagents necessary for the restriction digestion, ligation and PCR steps
should be stored in the pre-PCR clean room (or area for the DNA template
and free of PCR products) to minimize cross contamination between
samples. To avoid re-entering the pre-PCR clean room after entering either
the PCR-Staging Room or the Main Lab, Affymetrix recommends
aliquoting each of the reagents in the pre-PCR clean room before starting the
rest of the experiment.
The GeneChip Mapping 50K Assay kits are designed to allow only a 5%
excess in master mix volumes. If you need greater quantities in your
master mix, additional reagent kits may be needed.
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STEP 2: Restriction Enzyme Digestion

STEP 2: Restriction
Enzyme Digestion
Reagents and Equipment
■

250 ng Genomic DNA working stock: [50 ng/µL] per array

■

Xba I (20,000 U/mL): New England Biolab (NEB); P/N R0145L containing:

■

■

NE Buffer 2: New England Biolab (NEB); (P/N B7002S to order
separately)

■

BSA (Bovine Serum Albumin): New England Biolab (NEB);
(P/N B9001S to order separately)

Hind III (20,000 U/mL): New England Biolab (NEB); P/N R0104L
containing:
■

NE Buffer 2: New England Biolab (NEB); (P/N B7002S to order
separately)

■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

96-well plate: MJ Research; P/N MLP-9601; or Applied Biosystems;
P/N 403083

■

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

■

Thermal cycler (any Pre-PCR Clean Room thermocycler)

■

8-Tube Strips, thin-wall (0.2 mL): MJ Research, P/N TBS-0201; Strip of 8
caps: MJ Research, P/N TCS-0801
PCR tubes must be compatible and qualified with either MJ Research,
Tetrad, or ABI Geneamp 9700. For Example, Individual Tubes: MJ
Research P/N TWI-0201.
Using incompatible tubes with either the MJ Research Tetrad or the
GeneAmp 9700 could cause tubes to crush and lead to loss of sample.
The BSA is supplied as 100X (10 mg/mL), and needs to be diluted 1:10
with molecular biology grade water before use.
Reference Genomic DNA 103 is supplied in both the Xba and Hind
GeneChip® Mapping 50K Assay Kits, P/N 900520 and 900521
respectively. This DNA can be used as a positive control.
Reference Genomic DNA 103 tubes should be kept with the original kit
to avoid contamination.
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A process negative control can be included at the beginning of the
assay to assess the presence of contamination. Refer to Chapter 2 and
Chapter 7 for more information.

Digestion Procedure
Pre-PCR Clean Area

Depending on the restriction enzyme used, prepare the following
Digestion Master Mix ON ICE (for multiple samples make a 5%
excess):

1.

Xba I
Reagent Stock

1 Sample

H2O

10.5 µL

NE buffer 2 (10X)

2 µL

BSA (10X (1 mg/mL))

Hind III
Final Conc.
in Sample

Final Conc.
in Sample

Reagent Stock

1 Sample

H2O

10.5 µL

1X

NE buffer 2 (10X)

2 µL

1X

2 µL

1X

BSA (10X (1 mg/mL)) 2 µL

1X

Xba I (20 U/µL)

0.5 µL

0.5 U/µL

Hind III (20 U/µL)

0.5 µL

0.5 U/µL

Total

15 µL

Total

15 µL

Avoid processing samples with both Xba and Hind enzymes on the
same day. Best practice is to process samples for either Xba or Hind on
a given day.
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STEP 2: Restriction Enzyme Digestion

PCR Staging Area
2.

Add 5 µL genomic DNA (50 ng/µL) to each well of 96-well plate. Total
amount of genomic DNA is 250 ng for each Restriction Enzyme.

3.

Aliquot 15 µL of the Digestion Master Mix to each well of the 96-well
plate containing genomic DNA.

Reagent Stock

Volume/Sample

Genomic DNA (50 ng/µL)

5 µL

Digestion Master Mix

15 µL

Total Volume

20 µL

To expedite the aliquoting, the master mix can be first divided into 8 or
12 microwell strips and then dispensed into the plate with an 8-channel
or 12-channel pipette. Pipet up and down for several times to mix the
genomic DNA and digestion mix. Be sure to change tips between
samples.
4.

Cover the plate with a plate cover and seal tightly, vortex, and spin
briefly at 2,000 rpm for 1 minute.

5.

Place the plate in a thermal cycler and run the following program:

Temperature

Time

37ºC

120 minutes

70ºC

20 minutes

4ºC

Hold

Store sample at -20°C if not proceeding to the next step.
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STEP 3: Ligation
Reagents and Equipment
■

T4 DNA Ligase: New England Biolab (NEB); P/N M0202L containing:
■

T4 DNA Ligase Buffer: New England Biolab (NEB); P/N B0202S

■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

Adaptor Xba (5 µM); Affymetrix; P/N 900410, or Adaptor Hind (5 µM):
Affymetrix; P/N 900485 available in the GeneChip® Mapping 50K Assay
Kits, P/N 900520 and 900521, respectively

■

Thermal cycler (any Pre-PCR Clean Room thermocycler)
Avoid multiple freeze-thaw cycles with Ligase Buffer, according to
vendor’s instructions.

Ligation Procedure
Pre-PCR Clean Area

Depending on the restriction enzyme used, prepare the following
Ligation Master Mix ON ICE (for multiple samples make a 5% excess):

1.

Ligase buffer contains ATP and should be defrosted/ held at 4°C. Mix
ligase buffer thoroughly before use to ensure precipitate is resuspended. Avoid multiple freeze-thaw cycles, according to vendor’s
instructions.

Xba I

Hind III

Reagent

Final
1 Sample Conc. in
Sample

Reagent

1 Sample

Final
Conc. in
Sample

Adaptor Xba (5 µM)

1.25 µL

0.25 µM

Adaptor Hind (5 µM)

1.25 µL

0.25 µM

T4 DNA Ligase buffer (10X) * 2.5 µL

1X

T4 DNA Ligase buffer (10X) * 2.5 µL

1X

T4 DNA Ligase (400 U/µL)

0.625 µL

250 U

T4 DNA Ligase (400 U/µL)

0.625 µL

250 U

H2O

0.625 µL

H2O

0.625 µL

Total

5 µL

Total

5 µL

* Contains ATP and DTT. Keep on ice.

* Contains ATP and DTT. Keep on ice.
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STEP 3: Ligation

PCR Staging Area

Aliquot 5 µL of the Ligation Master Mix into each digested DNA
sample.

2.

Reagent

Volume/ Sample

Digested DNA

20 µL

Ligation mix*

5 µL

Total

25 µL

To expedite the aliquoting, the Ligation Master Mix can be first divided
into 8 or 12 microwell strips and then dispensed into the wells of the
plate with an 8-channel or 12-channel pipette. Pipet up and down for
several times to mix. Be sure to change tips between samples.
3.

Cover the plate with plate cover and seal tightly, vortex at medium
speed for 2 seconds, and spin briefly at 2,000 rpm for 1 minute.

4.

Place the plate in a thermal cycler and run the following program:

Temperature

Time

16ºC

120 minutes

70ºC

20 minutes

4ºC

Hold

Store samples at -20°C if not proceeding to the next step within 60
minutes.
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5.

Dilute each DNA ligation reaction by adding 75 µL of molecular
biology-grade H2O as described below:

Reagent

Volume/ Sample

Ligated DNA

25 µL

H2O

75 µL

Total

100 µL

It is crucial to dilute the ligated DNA with Molecular Biology Water prior
to PCR.
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STEP 4: PCR

STEP 4: PCR
Reagents and Equipment
■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

dNTP (2.5 mM each): Takara; P/N 4030, or Fisher Scientific;
P/N TAK 40301

■

PCR Primer (10 µM): Affymetrix; P/N 900409, available in the Xba and Hind
GeneChip® Mapping 50K Assay Kits, P/N 900520 and 900521, respectively
(see page 128 and 129 for sequence information)

■

Platinum Pfx DNA Polymerase (2.5 U/µL): Invitrogen Corporation,
P/N 11708-039 containing:
■

Pfx enzyme

■

10X Pfx Amplification Buffer

■

10X PCR Enhancer

■

50 mM MgSO4

■

2% TBE Gel: BMA Reliant precast (2% SeaKem Gold); P/N 54939

■

All Purpose Hi-Lo DNA Marker: Bionexus, Inc.; P/N BN2050, or
Direct Load Wide Range DNA Marker: Sigma; P/N D7058

■

Gel Loading Solution: Sigma; P/N G2526

■

Tubes:

■

■

Individual tubes: MJ Research; P/N TWI-0201

■

8-Tube Strips, thin-wall (0.2 mL): MJ Research, P/N TBS-0201; Strip of
8 caps: MJ Research, P/N TCS-0801

Plate:
■

■

96-well plate: MJ Research; P/N MLP-9601

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

1. dNTPs from Invitrogen (P/N R72501) have been tested on a limited basis with similar results. You should test in your own
lab prior to full scale production.
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■

PCR Thermal Cycler (this assay has only been optimized for the following
two thermal cyclers)1:
■

GeneAmp PCR System 9700, Applied Biosystems, or

■

DNA Engine Tetrad PTC-225, MJ Research

■
■

■
■
■

Program the thermal cycler in advance (see page 40).
Make sure the ligated DNA from the ligation step was diluted to 100 µL
with water.
Prepare PCR Master Mix in Pre-PCR Clean room.
Set up PCRs in PCR Staging Area.
Prepare 3 PCRs for each sample and for each restriction enzyme
(3 PCRs are required for each array).

1. The PCR process is covered by patents owned by Roche Molecular Systems, Inc. and F. Hoffmann-LaRoche Ltd (“Roche”).
A license to use the PCR process for certain research and development activities accompanies the purchase of certain
reagents from licensed suppliers when used in conjunction with an authorized thermal cycler. If you are using an MJ
Research thermal cycler, your thermal cycler may not be an authorized thermal cycler and it may be necessary for you to
obtain authorization from Roche or ABI (see PCR licensing information in the MJ Research User Manual). For information
about obtaining a license contact The Director of Licensing at Applied Biosystems, 850 Lincoln Center Drive, Foster City,
CA 94404 or the Licensing Department, Roche Molecular Systems, Inc., 1145 Atlantic Avenue, Alameda, CA 94501.
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STEP 4: PCR

PCR Procedure
Pre-PCR Clean Room
1.

Prepare the following PCR Master Mix ON ICE for Xba I or Hind III
ligation reactions and vortex at medium speed for 2 seconds (for
multiple samples make a 5% excess):
Final Conc. in

1 PCR

3 PCR

H2O

44 µL

132 µL

Pfx Amplification Buffer (10X)

10 µL

30 µL

1X

PCR Enhancer (10X)

10 µL

30 µL

1X

MgSO4 (50 mM)

2 µL

6 µL

1 mM

dNTP (2.5 mM each)

12 µL

36 µL

300 µM (each)

PCR Primer (10 µM)

10 µL

30 µL

1 µM

Pfx Polymerase (2.5 U/µL)

2 µL

6 µL

0.05 U/µL

90 µL

270 µL

Stock Reagent

Total

Sample

40 µg of PCR product is needed for fragmentation. If this yield is
achieved consistently with 2 PCRs, the number of PCR reactions can
be reduced.
A PCR negative control can be included in the experiment to assess the
presence of contamination. Refer to Chapter 2 and Chapter 7 for more
information.
Prepare fresh PCR Master Mix just prior to use.
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PCR Staging Area
2.

Transfer 10 µL of each of the diluted ligated DNA from the 96-well
plate into the corresponding three individual wells of the PCR plates
using an 8- or 12-channel pipette. Be sure to change tips between
samples.

3.

Add 90 µL PCR Master mix to obtain a total volume of 100 µL. Final
volume for each PCR is listed in the table below.
It is convenient to dispense the PCR Master Mix with a repetitive
dispenser (such as Gilson Distriman®, available from Ranin) or pipet the
PCR Master Mix from a solution basin (Labcor Products, Inc., Cat. No.
730-014; available from PGC Scientifics) with an 8-channel or 12-channel
pipette.

Reagent

Volume/PCR

PCR Master Mix

90 µL

Diluted ligated DNA (from Ligation step)

10 µL

Total

100 µL

Three PCR reactions are needed to produce sufficient product for
hybridization to one array (each reaction = 100 µL).
4.

Seal the plate with plate cover, vortex at medium speed for 2 seconds,
and spin briefly at 2,000 rpm for 1 minute.

5.

Run the following PCR protocols on either an MJ DNA Engine Tetrad
or GeneAmp PCR System 9700.

Main Lab

PCR protocols for MJ and PE thermal cyclers are different as listed on
the following page.

39

40

STEP 4: PCR

MJ DNA Engine Program:
Use Heated Lid and Calculated Temperature. Program the thermal cycler
in advance with the following protocol:
Temperature

Time

Cycles

94ºC

3 minutes

1X

94ºC

15 seconds

60ºC

30 seconds

68ºC

60 seconds

68ºC

7 minutes

4ºC

HOLD

}

30X

1X

Gene Amp PCR System 9700 Program:
Specify 100 µL volume and maximum mode.
Temperature

Time

Cycles

94ºC

3 minutes

1X

94ºC

30 seconds

60ºC

45 seconds

68ºC

60 seconds

68ºC

7 minutes

4ºC

HOLD

6.

}

30X

1X

Run 3 µL of each PCR product mixed with 3 µL 2X Gel Loading Dye
on 2% TBE gel at 120V for 1 hour.
PCR products can be stored at -20°C if not proceeding to the next step
within 60 minutes.

GeneChip® Mapping 100K Assay Manual

2000
1000
750
500
300
100

Figure 4.2
Example of PCR products run on 2% TBE agarose gel at 120V for 1 hour, with average size
between 250 and 2,000 bp.
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STEP 5: PCR Purification and Elution with QIAGEN MinElute™ 96 UF PCR Purification Plate

STEP 5: PCR Purification
and Elution with QIAGEN
MinElute™ 96 UF PCR
Purification Plate
Reagents and Equipment
■

Manifold - QIAvac multiwell unit: QIAGEN P/N 9014579

■

MinElute 96 UF PCR Purification Kit: QIAGEN P/N 28051 (four plates), or
P/N 28053 (24 plates)

■

Buffer EB (1000 mL): QIAGEN P/N120002

■

Biomek Seal and Sample Aluminum Foil Lids: Beckman P/N 538619

■

Jitterbug 115 VAC: Boekel Scientific P/N 130000

■

Vacuum Regulator for use during the PCR clean up step. QIAGEN
Vacuum Regulator (use with QIAvac manifolds): QIAGEN; P/N 19530*
* The QIAGEN protocol requires ~800 mb vacuum. If your lab does not
have an internally regulated vacuum source, this vacuum regulator is
strongly suggested

Follow the steps as outlined below. Consult the QIAGEN MinElute
Handbook for the general procedure and ordering information.
1.

Connect a vacuum manifold to a suitable vacuum source able to
maintain ~800 mbar, e.g., QIAvac Multiwell Unit (QIAGEN). Place a
waste tray inside the base of the manifold.

2.

Place a MinElute 96 UF PCR Purification Plate on top of the manifold.
Cover wells that are not needed with PCR plate cover.
To cover the unneeded wells, a PCR plate cover or an aluminum foil lid
can be placed on top of the MinElute plate. Apply pressure to make the
cover stick to the plate. Then using a razor, cut between the needed and
unneeded wells. Remove the portion that covers the needed wells.

3.

Consolidate the PCR reactions for each sample into one well of the
MinElute plate.
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For PCR samples prepared in three 96-well PCR plates, an 8- or 12channel pipette can be used to transfer each row of 12 samples in the
PCR plates to the corresponding row of the MinElute plate. With the
vacuum on, the three PCR reactions for each sample (300 µL) can be
combined into one well of the MinElute plate.
When solution is pipetted into the well of the MinElute plate, be careful
not to pierce the membrane.
Make sure the orientations of PCR plates are consistent.
Use a method of distinguishing between used and unused wells on the
plate.
4.

Apply a vacuum and maintain at ~800 mbar until the wells are
completely dry.

5.

Wash the PCR products by adding 50 µL molecular biology water and
dry the wells completely (approximately 20 minutes). Repeat this step
2 additional times for a total of 3 water washes.

6.

Switch off vacuum source and release the vacuum.

7.

Carefully remove the MinElute plate from the vacuum manifold.

8.

Gently tap the MinElute plate on a stack of clean absorbent paper to
remove any liquid that might remain on the bottom of the plate.

9.

Add 40 µL EB buffer to each well. Cover the plate with PCR plate cover
film.

10.

Moderately shake the MinElute plate on a plate shaker, e.g., Jitterbug
(Boekel Scientific, model 130000), for 5 minutes at room temperature.

11.

Recover the purified PCR product by pipetting the eluate out of each
well. For easier recovery of the eluates, the plate can be held at a slight
angle.
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STEP 6: Quantification of Purified PCR Product

STEP 6: Quantification of
Purified PCR Product
1.

Use spectrophotometric analysis to determine the purified PCR product
yield. If available, a plate reader is preferred for efficient DNA
concentration determination.

2.

Add 4 µL of purified PCR product to 156 µL molecular water (40-fold
dilution) and MIX WELL.

3.

Read the absorbance at 260 nm. Ensure that the reading is in the
quantitative range of the instrument (generally 0.2 to 0.8 OD).

4.

Apply the convention* that 1 absorbance unit at 260 nm equals
50 µg/mL for double-stranded PCR product.
*This convention assumes a path length of 1 cm. Consult your spectrophotometer handbook for
further information.

5.

Adjust the DNA concentration to 40 µg of PCR product per 45 µL
solution by adding EB buffer (10mM Tris-HCl, pH 8.5).

6.

Transfer 45 µL (40 µg) of each of the purified DNA to corresponding
wells of a new plate for fragmentation.
If 40 µg of PCR product has a volume less than 45 µL, make up the
volume to 45 µL by adding EB Buffer (10 mM Tris-Cl, pH 8.5).
The spectrophotometer should be regularly calibrated to ensure correct
readings.
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STEP 7: Fragmentation
Reagents and Equipment
■

Fragmentation Reagent (DNase I): Affymetrix, P/N 900131

■

10X Fragmentation Buffer: Affymetrix, P/N 900422

■

Molecular Biology Water: Bio Whittaker Molecular Applications/Cambrex,
P/N 51200

■

4% TBE Gel: BMA Reliant precast (4% NuSieve 3:1 Plus Agarose);
P/N 54929

■

All Purpose Hi-Lo DNA Marker: Bionexus, Inc.; 50 - 10000bp; P/N BN2050

■

Gel Loading Solution: Sigma; P/N G2526

■

96-well plate: MJ Research; P/N MLP-9601

■

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

■

Thermal cycler
■

DNA Engine Tetrad: MJ Research, or

■

Gene Amp PCR System 9700

Main Lab
Fragmentation of PCR product before hybridization onto GeneChip
probe arrays has been shown to be critical in obtaining optimal assay
performance. Due to the sensitive nature of the Fragmentation Reagent
(DNase I), these general rules need to be followed to ensure the success
of the step:
■
■

■

■
■

■
■
■

Store the Fragmentation Reagent stock at -20ºC until ready for use.
Make sure the purified PCR products are in EB buffer with proper
volume (45 µL).
Pre-heat the thermal cycler at 37°C before setting up the fragmentation
reaction.
Prepare the Fragmentation Reagent dilution immediately prior to use.
Prepare diluted Fragmentation Reagent in excess to avoid errors in
taking a small volume of Fragmentation Reagent.
Perform all the dilution, addition and mixing steps ON ICE.
Perform all the steps AS QUICKLY AS POSSIBLE.
Discard remaining Diluted Fragmentation Reagent after use.
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STEP 7: Fragmentation

Fragmentation Procedure
1.

Pre-heat thermal cycler to 37°C.

2.

Add 5 µL 10X Fragmentation Buffer to each sample on the
fragmentation plate ON ICE and vortex at medium speed for 2 seconds.
Place back on ice.

Reagent

Volume/ Sample

Purified PCR product (40 µg in EB buffer)

45 µL

10X Fragmentation Buffer

5 µL

Total

50 µL

3.

Examine the label of the GeneChip Fragmentation Reagent tube for
U/µL definition, and calculate dilution.
Y = number of µL of stock Fragmentation Reagent
X = number of U of stock Fragmentation Reagent per µL (see label
on tube)
0.04 U/µL = final concentration of diluted Fragmentation Reagent
150 µL = final volume of diluted Fragmentation Reagent*

Y=

0.04 U/µL * 150 µL
X U/µL

* enough for 20 reactions

As the concentration of stock Fragmentation Reagent (U/µL) may vary
from lot to lot, it is essential to check the concentration before
conducting the dilution. Do calculations prior to diluting sample and
Fragmentation Reagent.
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Dilute the stock of Fragmentation Reagent to 0.04 U/µL using
Fragmentation Buffer and Molecular Biology Water ON ICE and vortex
at medium speed for 2 seconds.
Two examples of dilution are listed below for two different
concentrations of Fragmentation Reagent.

4.

Reagent
Fragmentation Reagent

2 units/µL

3 units/µL

3 µL

2 µL

10X Fragmentation Buffer

15 µL

15 µL

H2O

132 µL

133 µL

Total

150 µL

150 µL

The Fragmentation Reagent is viscous so it is important that it is mixed
well.

If the concentration on your tube is not shown in the table above, use the
formula provided in step 3.
5.

Divide the diluted Fragmentation Reagent into 8 or 12 microwell strips
ON ICE.

6.

Add 5 µL of diluted Fragmentation Reagent (0.04 U/µL) with an 8- or
12-channel pipette to the fragmentation plate containing Fragmentation
Mix ON ICE. Pipet up and down several times to mix. Be sure to
change tips between samples. The total volume for each sample is listed
below.

Reagent

Volume/Sample

Fragmentation Mix

50 µL

Diluted Fragmentation Reagent (0.04 U/µL)

5 µL

Total

55 µL

For 40 µg of purified PCR product, a total of 0.2 U of Fragmentation
Reagent is needed in a final reaction volume of 55 µL.
7.

Cover the fragmentation plate with a plate cover and seal tightly.
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STEP 7: Fragmentation

8.

Vortex the fragmentation plate at medium speed for 2 seconds, and spin
briefly at 2,000 rpm for 1 minute.

9.

Place the fragmentation plate in pre-heated thermal cycler (37°C) as
quickly as possible.
Make sure the reaction tubes/plates are securely sealed prior to running
this program in order to minimize solution loss due to evaporation at
the DNase I inactivation step (95°C).
Seal the tubes/plates to make sure all reaction tubes fit snugly into the
wells of the heating block. Do not use a low-quality substitute of the 96well plate or PCR tubes that do not fit with the thermal cycler.

10.

Run the following program:

Temperature

Time

37ºC

35 minutes

95ºC

15 minutes

4ºC

Hold

11.

Spin the plate briefly after fragmentation reaction.

12.

Dilute 4 µL of fragmented PCR product with 4 µL gel loading dye and
run on 4% TBE gel at 120V for 30 minutes to 1 hour. (See Figure 4.3.)

13.

Proceed immediately to Labeling step, if your gel matches the example below.

200
100
50

Figure 4.3
Example of fragmented PCR products run on 4% TBE agarose gel at 120V for 30 minutes to
1 hour, with average size < 180 bp
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STEP 8: Labeling
Reagents
■

GeneChip DNA Labeling Reagent (7.5 mM): Affymetrix; P/N 900484,
available in the Xba I and Hind III GeneChip® Mapping 50K Assay Kits,
P/N 900520 and P/N 900521, respectively

■

Terminal Deoxynucleotidyl Transferase (30 U/µL): Affymetrix; P/N 900426,
available in the Xba I and Hind III GeneChip® Mapping 50K Assay Kits,
P/N 900520 and P/N 900521, respectively

■

5X Terminal Deoxynucleotidyl Transferase Buffer: Affymetrix; P/N 900425,
available in the Xba I and Hind III GeneChip® Mapping 50K Assay Kits,
P/N 900520 and P/N 900521, respectively

Labeling Procedure
Main Lab
1.

Prepare Labeling Mix as master mix ON ICE and vortex at medium
speed for 2 seconds (for multiple samples make a 5% excess).

Reagent

1X

Final Conc. in Sample

5X TdT Buffer

14 µL

1X

GeneChip DNA Labeling Reagent (7.5 mM)

2 µL

0.214 mM

TdT (30 U/µL)

3.5 µL

1.5 U/µL

Total

19.5 µL

2.

Aliquot 19.5 µL of Labeling Master Mix into the fragmentation plate
containing 50.5 µL of fragmented DNA samples as follows:

Reagent

Volume/ Rx

Fragmented DNA
50.5 µL
(from Fragmentation step)
Labeling Mix

19.5 µL

Total

70 µL

Remaining fragmented DNA
is used for gel analysis
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STEP 8: Labeling

To expedite the aliquoting, the Labeling Master Mix can be first divided
into 8 or 12 microwell strips and then dispensed into the wells of the
plate with an 8- or 12-channel pipette. Pipet up and down several times
to mix. Be sure to change tips between samples.
3.

Seal the plate tightly with a plate cover.

4.

Vortex the plate at medium speed for 2 seconds, and briefly spin the
plate at 2,000 rpm for 1 minute.

5.

Run the following program:

Temperature

Time

37ºC

2 hours

95ºC

15 minutes

4ºC

Hold

Make sure the plates/reaction tubes are securely sealed prior to running
this program in order to minimize solution loss due to evaporation at
denaturation step (95°C).
6.

Briefly spin the plate at 2,000 rpm for 1 minute after the labeling
reaction.
Samples can be stored at -20°C if not proceeding to next step.
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STEP 9: Target
Hybridization
Reagents
■

5M TMACL (Tetramethyl Ammonium Chloride): Sigma; P/N T3411

■

10% Tween-20: Pierce; P/N 28320 (Surfactamps); diluted to 3% in
molecular biology grade water

■

MES hydrate SigmaUltra: Sigma; P/N M5287

■

MES Sodium Salt: Sigma; P/N M5057

■

DMSO: Sigma; P/N D5879

■

EDTA: Ambion; P/N 9260G

■

Denhardt’s Solution: Sigma; P/N D2532

■

HSDNA (Herring Sperm DNA): Promega; P/N D1815

■

Human Cot-1: Invitrogen; P/N 15279-011

■

Oligo Control Reagent, 0100 (OCR, 0100): Affymetrix; P/N 900541,
available in the Xba and Hind GeneChip® Mapping 50K Assay Kits,
P/N 900520 and P/N 900521, respectively

Reagent Preparation

12 X MES Stock
(1.22 M MES, 0.89 M [Na+])
Do not autoclave. Store between 2ºC and 8ºC, and shield from light.
Discard solution if it turns yellow.

For 1000 mL:
70.4 g MES hydrate
193.3 g MES Sodium Salt
800 mL Molecular Biology Grade water
Mix and adjust volume to 1,000 mL.
The pH should be between 6.5 and 6.7.
Filter through a 0.2 µm filter.
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STEP 9: Target Hybridization

Hybridization Procedure
Gloves, safety glasses, and lab coats must be worn when preparing the
hybridization cocktail. Please consult the appropriate MSDS for reagent
storage and handling requirements.
It is important to allow the arrays to equilibrate to room temperature
completely. Specifically, if the rubber septa are not equilibrated to
room temperature, they may be prone to cracking, which can lead to
leaks.
1.

Prepare the following Hybridization Cocktail Master Mix (for multiple
samples make a 5% excess):

Reagent

1X

Final Conc. in Sample

MES (12X; 1.22 M)

12 µL

0.056 M

DMSO (100%)

13 µL

5.0%

Denhardt’s Solution (50X)

13 µL

2.50X

EDTA (0.5 M)

3 µL

5.77 mM

HSDNA (10 mg/mL)

3 µL

0.115 mg/mL

OCR, 0100

2 µL

1X

Human Cot-1 (1 mg/mL)

3 µL

11.5 µg/mL

Tween-20 (3%)

1 µL

0.0115%

TMACL (5M)

140 µL

Total

190 µL

2.69 M

Mix well.
2.

Transfer each of the labeled samples from the plate to a 1.5 mL
Eppendorf tube. Aliquot 190 µL of the Hybridization Cocktail Master
Mix into the 70 µL of labeled DNA samples as follows:

Reagent
Labeled DNA

Volume/ Rx
70 µL

Hybridization Mix

190 µL

Total

260 µL
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This Hybridization Cocktail Master Mix can be stored at -20°C before
proceeding to the next step.
3.

Heat the 260 µL of hybridization mix and labeled DNA at 95°C in a
heat block for 10 minutes to denature.

4.

Cool down on crushed ice for 10 seconds.
Do not leave on ice for longer than 10 seconds.

5.

Spin briefly at 2,000 rpm for 1 minute in a microfuge to collect any
condensate.
If there is anything that has come out of the solution, pipette briefly to
resuspend before adding solution to the array.

6.

Place the tubes at 48°C for 2 minutes.

7.

Inject 200 µL denatured hybridization into the array.

8.

Hybridize at 48°C for 16 to 18 hours at 60 rpm.
The remaining hybridization mix can be stored at -20°C for future use.
The hybridization temperature is 48°C. This is different from the
GeneChip expression assay.
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STEP 9: Target Hybridization

5

Chapter 5

Mapping Arrays: Washing, Staining, and
Scanning

This chapter contains instructions for using the Fluidics Station 400
and 450/250 to automate the washing and staining of GeneChip®
Mapping 50K Arrays, and instructions for scanning probe arrays
using the GeneChip® Scanner 3000.
After completing the procedures described in this chapter, the scanned
probe array image (.dat file) is ready for analysis.
Prior to scanning Mapping 50K arrays for the first time, be sure to run
the ScannerUpdate Application. For more information, see
ScannerUpdate Application on page 72.
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Reagents and Materials Required

Reagents and Materials
Required
The following reagents and materials are recommendations and have been
tested and evaluated by Affymetrix scientists. Information and part numbers
listed are based on U.S. catalog information.
■

Water, Molecular Biology Grade, BioWhittaker Molecular Applications /
Cambrex, P/N 51200

■

Distilled water, Invitrogen Life Technologies, P/N 15230147

■

20X SSPE (3M NaCl, 0.2M NaH2PO4, 0.02 M EDTA), BioWhittaker
Molecular Applications / Cambrex, P/N 51214

■

Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories,
P/N BA-0500; reconstitute according to product instructions

■

R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866

■

10% surfact-Amps20 (Tween-20), Pierce Chemical, P/N 28320

■

Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504
(or equivalent)

■

Denhardt’s Solution, 50X concentrate: Sigma; P/N D2532

■

MES hydrate, Sigma-Aldrich, P/N M5287

■

MES Sodium Salt, Sigma-Aldrich, P/N M5057

■

5M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

Miscellaneous Supplies
■

Sterile, RNase-free, microcentrifuge vials, 1.5 mL, USA Scientific,
P/N 1415-2600 (or equivalent)

■

Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)

■

Sterile-barrier pipette tips and non-barrier pipette tips

■

Tygon Tubing, 0.04” inner diameter, Cole-Parmer, P/N H-06418-04

■

Tough-Spots™, Label Dots, USA Scientific, P/N 9185
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Reagent Preparation
Wash A: Non-Stringent Wash Buffer
(6X SSPE, 0.01% Tween 20)
For 1000 mL:
300 mL of 20X SSPE
1.0 mL of 10% Tween-20
699 mL of water
Filter through a 0.2 µm filter.
Store at room temperature.
Wash B: Stringent Wash Buffer
(0.6X SSPE, 0.01% Tween 20)
For 1000 mL:
30 mL of 20X SSPE
1.0 mL of 10% Tween-20
969 mL of water
Filter through a 0.2 µm filter.
Store at room temperature.
0.5 mg/mL Anti-Streptavdin Antibody
Resuspend 0.5 mg in 1 mL of water.
Store at 4°C.
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Reagent Preparation

12X MES Stock Buffer
(1.22M MES, 0.89M [Na+])
For 1,000 mL:
70.4g of MES hydrate
193.3g of MES Sodium Salt
800 mL of Molecular Biology Grade water
Mix and adjust volume to 1,000 mL.
The pH should be between 6.5 and 6.7.
Filter through a 0.2 µm filter.
Do not autoclave. Store at 2°C to 8°C, and shield from light.
Discard solution if yellow.

1X Array Holding Buffer
(Final 1X concentration is 100 mM MES, 1M [Na+], 0.01% Tween-20)
For 100 mL:
8.3 mL of 12X MES Stock Buffer
18.5 mL of 5M NaCl
0.1 mL of 10% Tween-20
73.1 mL of water
Store at 2°C to 8°C, and shield from light
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Experiment and Fluidics
Station Setup
The following instructions are for GeneChip Operating Software (GCOS)
1.1.1 with Patch 5 or GeneChip Operating Software Server (GCOS Server).
Step 1: Registering a New Experiment in GCOS
1.

From the File menu click New Experiment.
⇒ The New Experiment window appears in the display pane
(Figure 5.1).
■

Figure 5.1
GCOS Sample Entry Pane

The top half of the display pane refers to the sample and the bottom
half refers to the experiment.
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Experiment and Fluidics Station Setup

2.

3.

Enter information into the appropriate boxes.
■

Fields that are highlighted in bold require an entry.

■

Drop-down menus are available for Sample/Project information
(default information can be used or new information can be entered).

■

The Experiment Name must be unique.

■

Appropriate library files must be installed for a probe array to appear
in the drop-down menu.

From the File menu click Save As, or click the Save icon on the tool bar
to register the experiment into the database.
The Sample Information fields can be customized. See the GCOS User’s
Guide for further information.

Step 2: Preparing the Fluidics Station

The Fluidics Station 400, 450 or 250 is used to wash and stain the probe
arrays; it is operated using GeneChip Operating Software.
Setting Up the Fluidics Station
1.

2.

Turn on the Fluidics Station using the toggle switch on the lower left
side of the machine.
Select Run → Fluidics from the menu bar in GCOS.
⇒ The Fluidics Station dialog box appears with a drop-down list for
selecting the experiment name for each of the fluidics station
modules. A second drop-down list is accessed for choosing the
Protocol for each of the fluidics station modules. Use the radio
buttons to access each module.
Refer to the Fluidics Station User’s Guide for instructions on connecting
and addressing multiple fluidics stations.
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Priming the Fluidics Station
Priming ensures the lines of the fluidics station are filled with the
appropriate buffers and the fluidics station is ready to run fluidics station
protocols.
Priming should be done:
■

when the fluidics station is first started.

■

when wash solutions are changed.

■

before washing, if a shutdown has been performed.

■

if the LCD window instructs the user to prime.

1.

To prime the fluidics station, select Protocol in the Fluidics Station
dialog box.

2.

Choose Prime for the respective modules in the Protocol drop-down
list.

3.

Change the intake buffer reservoir A to Non-Stringent Wash Buffer,
and intake buffer reservoir B to Stringent Wash Buffer.

4.

Click Run for each module to begin priming.

5.

Follow LCD instructions.
All modules can be selected by selecting the All Modules button in the
fluidics dialog box.
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Probe Array Wash and Stain

Probe Array Wash and Stain
The Affymetrix staining protocol for Mapping arrays is a three stage process
consisting of a Streptavidin Phycoerythin (SAPE) stain, followed by an
antibody amplification step and final stain with Streptavidin Phycoerythin
(SAPE). Following staining, the array is filled with Array Holding Buffer
prior to scanning as outlined in Table 5.5 and Table 5.6.
1.

After 16 hours of hybridization, remove the hybridization cocktail from
the probe array and set it aside in a microcentrifuge vial. Store on ice
during the procedure or at -80°C for long-term storage.

2.

Fill the probe array completely with 250 µL of Array Holding Buffer.
If necessary, the probe array can be stored in the Array Holding Buffer
at 4°C for up to 3 hours before proceeding with washing and staining.
Equilibrate the probe array to room temperature before washing and
staining.

Preparing the Staining Reagents
Prepare the following reagents. Volumes given are sufficient for one probe
array. Mix well.
Stain Buffer
Table 5.1
Stain Buffer

Components
H2O
SSPE (20X)

1X

Final Concentration

666.7 µL
300 µL

6X

Tween-20 (3%)

3.3

0.01%

Denhardt’s (50X)

20

1X

Subtotal

990 µL

Subtotal / 2

495 µL
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SAPE Stain Solution
Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C,
either foil-wrapped or in an amber tube. Remove SAPE from refrigerator
and tap the tube to mix well before preparing stain solution. Always prepare
the SAPE stain solution immediately before use. Do not freeze either
concentrated SAPE or diluted SAPE stain solution.
Table 5.2
SAPE Solution Mix

Components

Volume

Final Concentration

Stain Buffer

495 µL

1X

1 mg/mL Streptavidin Phycoerythrin (SAPE)

5.0 µL

10 µg/mL

Total

500 µL

Mix well.
FS450 Users: A vial containing SAPE Stain Solution must be placed in
sample holder 1 for each module used.
FS400 Users: A vial containing SAPE Stain Solution must be used for

the first and third stains.
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Antibody Stain Solution
Table 5.3
Antibody Solution Mix

Components
Stain Buffer
0.5 mg/mL biotinylated antibody
Total

Volume

Final Concentration

495 µL

1X

5 µL

5 µg/mL

500 µL

Mix well.
FS450 Users: A vial containing Antibody Stain Solution must be placed
in sample holder 2 for each module used.
FS400 Users: A vial containing Antibody Stain Solution must be used

for the second stain.

Array Holding Buffer
Table 5.4
Array Holding Buffer

Components

Volume

MES Stock Buffer (12X)

8.3 mL

5M NaCl

18.5 mL

Tween-20 (10%)

0.1 mL

Water

73.1 mL

Total

100 mL

Add 800 µL of Array Holding Buffer to each microcentrifuge tube.
One tube is needed per module used.
FS450 Users: A vial containing Array Holding Buffer must be placed in
sample holder 3 for each module used.
FS400 Users: A vial containing Array Holding Buffer must be used at

the final step in the fluidics protocol. This will ensure that the array is
filled with Array Holding Buffer when the fluidics protocol is complete.
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Table 5.5
FS-450 Fluidics Protocol - Antibody Amplification for Mapping Targets
(protocols for the Fluidics Station 450/250 will have _450 as a suffix)

49 Format (Standard)
Mapping100Kv1_450
Post Hyb Wash #1

6 cycles of 5 mixes/cycle with Wash Buffer A at 25°C

Post Hyb Wash #2

6 cycles of 5 mixes/cycle with Wash Buffer B at 45°C

Stain

Stain the probe array for 10 minutes in SAPE solution at 25°C

Post Stain Wash

6 cycles of 5 mixes/cycle with Wash Buffer A at 25°C

2nd Stain

Stain the probe array for 10 minutes in antibody solution at 25°C

3rd Stain

Stain the probe array for 10 minutes in SAPE solution at 25°C

Final Wash

10 cycles of 6 mixes/cycle with Wash Buffer A at 30°C. The final
holding temperature is 25°C

Filling Array

Fill the array with Array Holding Buffer.

Wash Buffer A = non-stringent wash buffer
Wash Buffer B = stringent wash buffer

Table 5.6
FS-400 Fluidics Protocol - Antibody Amplification for Mapping Targets

49 Format (Standard)
Mapping100Kv1
Post Hyb Wash #1

6 cycles of 5 mixes/cycle with Wash Buffer A at 25°C

Post Hyb Wash #2

6 cycles of 5 mixes/cycle with Wash Buffer B at 45°C

Stain

Stain the probe array for 10 minutes in SAPE solution at 25°C

Post Stain Wash

6 cycles of 5 mixes/cycle with Wash Buffer A at 25°C

2nd Stain

Stain the probe array for 10 minutes in antibody solution at 25°C

3rd Stain

Stain the probe array for 10 minutes in SAPE solution at 25°C

Final Wash

10 cycles of 6 mixes/cycle with Wash Buffer A at 30°C. The
holding temperature is 25°C

Filling Array

Fill the array with Array Holding Buffer.

Wash Buffer A = non-stringent wash buffer
Wash Buffer B = stringent wash buffer
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Washing and Staining the Probe Array Using FS-450/250
The wash and staining buffers are different from the GeneChip
expression buffers.

If you are using the Fluidics Station 450/250:
1.

In the Fluidics Station dialog box on the workstation, select the correct
experiment name from the drop-down Experiment list. The Probe
Array Type appears automatically.

2.

In the Protocol drop-down list, select Mapping100Kv1_450, to control
the washing and staining of the probe array.

3.

Choose Run in the Fluidics Station dialog box to begin the washing and
staining. Follow the instructions in the LCD window on the fluidics
station.
If you are unfamiliar with inserting and removing probe arrays from the
fluidics station modules, please refer to the appropriate Fluidics Station
User’s Guide, or Quick Reference Card (P/N 08-0093 for the FS-450/
250 fluidics stations).

4.

Insert the appropriate probe array into the designated module of the
fluidics station while the cartridge lever is in the down or eject position.
When finished, verify that the cartridge lever is returned to the up or
engaged position.

5.

Remove any microcentrifuge vials remaining in the sample holders of
the fluidics station module(s) being used.

6.

When prompted to “Load Vials 1-2-3,” place the three vials into the
sample holders 1, 2 and 3 on the fluidics station.
■

Place one vial containing 500 µL Streptavidin Phycoerythrin (SAPE)
stain solution mix in sample holder 1.

■

Place one vial containing 500 µL anti-streptavidin biotinylated
antibody stain solution in sample holder 2.

■

Place one vial containing 800 µL Array Holding Buffer in sample
holder 3.

■

Press down on the needle lever to snap needles into position and to
start the run.
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Once these steps are complete, the fluidics protocols begin. The Fluidics
Station dialog box at the workstation terminal and the LCD window
displays the status of the washing and staining steps.
7.

When staining is finished, remove the microcentrifuge vials containing
stain and replace with three empty microcentrifuge vials as prompted.

8.

Remove the probe arrays from the fluidics station modules by first
pressing down the cartridge lever to the eject position.

9.

Check the probe array window for large bubbles or air pockets.
■

If bubbles are present, the probe array should be filled with Array
Holding Buffer manually, using a pipette. Take out one-half of the
solution and then manually fill the probe array with Array Holding
Buffer.

■

If the probe array has no large bubbles, it is ready to scan on the
GeneChip Scanner 3000. Pull up on the cartridge lever to engage
wash block and proceed to Probe Array Scan on page 72.

If a bubble is present, do not return the probe array to the probe array
holder. The probe array must be filled manually with Array Holding
Buffer.

If you can not scan the arrays right away, keep the probe arrays at 4°C
and in the dark until ready for scanning. Scan must be preformed within
24 hours.
If no more samples require washing and staining, shut down the fluidics
station following the procedure outlined in the section, Shutting Down
the Fluidics Station on page 75.
For proper cleaning and maintenance of the fluidics station, including
the bleach protocol, please refer to Chapter 6, Fluidics Station
Maintenance Procedures.
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Washing and Staining the Probe Array Using FS-400
The wash and staining buffers are different from the GeneChip
expression buffers.

If you are using the Fluidics Station 400:
1.

In the Fluidics Station dialog box on the workstation, select the correct
experiment name in the drop-down Experiment list. The probe array
type will appear automatically.

2.

In the Protocol drop-down list, select Mapping100Kv1, to control the
washing and staining of the probe array.

3.

Choose Run in the Fluidics Station dialog box to begin the washing and
staining. Follow the instructions on the LCD window on the fluidics
station.

4.

If you are unfamiliar with inserting and removing probe arrays from the
fluidics station modules, please refer to the Fluidics Station 400 User’s
Guide, or Quick Reference Card (P/N 08-0072).

5.

Insert the appropriate probe array into the designated module of the
fluidics station while the cartridge lever is in the EJECT position.
When finished, verify the cartridge lever is returned to the ENGAGE
position.

6.

Remove any microcentrifuge vials remaining in the sample holders of
the fluidics station module(s) being used.

7.

When the LCD window indicates, place the microcentrifuge vial
containing 500 µL Streptavidin Phycoerythrin (SAPE) solution into the
sample holder. Verify that the metal sampling needle is in the vial with
its tip near the bottom.

8.

When the LCD window indicates, replace the microcentrifuge vial
containing the SAPE stain solution with a microcentrifuge vial
containing antibody stain solution into the sample holder, making sure
that the metal sampling needle is in the vial with its tip near the bottom.

9.

When the LCD window indicates, replace the microcentrifuge vial
containing the antibody stain solution with the first microcentrifuge vial
containing 500 µL Streptavidin Phycoerythrin (SAPE) stain solution
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into the sample holder. Verify the metal sampling needle is in the vial
with its tip near the bottom.
10.

When the LCD window indicates, replace the microcentrifuge vial
containing the SAPE solution with a microcentrifuge vial containing
800 µL Array Holding Buffer.
⇒ The Fluidics Station dialog box and the LCD window display the
status of the washing and staining as they progress. When the wash
is complete, the LCD window displays the message EJECT
CARTRIDGE.

11.

Remove microcentrifuge vial containing Array Holding Buffer and
replace with an empty microcentrifuge vial.

12.

Remove the probe arrays from the fluidics station modules by first
moving the probe array holder lever to the EJECT position.

13.

Check the probe array window for large bubbles or air pockets.
■

If bubbles are present, the probe array should be filled with Array
Holding Buffer manually, using a pipette. Take out one-half of the
solution and then manually fill the probe array with Array Holding
Buffer.

■

If the probe array has no large bubbles, it is ready to scan on the
GeneChip Scanner 3000. Pull up on the cartridge lever to engage
wash block and proceed to Probe Array Scan on page 72.

If a bubble is present, do not return the probe array to the probe array
holder. The probe array must be filled manually with Array Holding
Buffer.

If you can not scan the arrays right away, keep the probe arrays at 4°C
and in the dark until ready for scanning. Scan within 24 hours.
If there are no more samples to wash and stain, shut down the fluidics
station following the procedure outlined in the section, Shutting Down
the Fluidics Station on page 75.
For proper cleaning and maintenance of the fluidics station including
the bleach protocol, please refer to Chapter 6, Fluidics Station
Maintenance Procedures.
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Probe Array Scan
The scanner is also controlled by GCOS Software 1.1.1 with Patch 5, or
higher. The probe array is scanned after the wash protocols are complete.
Make sure the laser is warmed up prior to scanning by turning the GeneChip
Scanner 3000 laser on at least 10 minutes before use. If the probe array was
stored at 4°C, allow to warm to room temperature before scanning.
Refer to the GCOS online help, tutorials, and User’s Guide for more
information on scanning.
The scanner uses a laser and is equipped with a safety interlock system.
Defeating the interlock system may result in exposure to hazardous
laser light.
You must have read and be familiar with the operation of the scanner
before attempting to scan a probe array. Please refer to the GeneChip
Scanner 3000 Quick Reference Card (P/N 08-0075).

ScannerUpdate Application

The ScannerUpdate Application is a Windows based application for
configuring the GCS3000 to enable the scanning of Mapping 50K arrays.
It must be installed once on the instrument workstation before arrays are
scanned. It can be downloaded from the following URL:
www.affymetrix.com/support/technical/updates.affx
Handling the GeneChip® Probe Array

Before you scan the probe array, follow the directions in this section on
handling the probe array. If necessary, clean the glass surface of the probe
array with a non-abrasive towel or tissue before scanning. Do not use
alcohol to clean the glass.
Before scanning the probe array cartridge, Tough-Spots™ can be applied to
each of the two septa on the probe array cartridge to prevent the leaking of
fluids from the cartridge during scanning.
Apply the spots just before scanning. Do not use them in the washing
and staining process.
1.

On the back of the probe array cartridge, clean excess fluid from around
the septa.
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2.

Carefully apply one Tough-Spot to each of the two septa. Press to
ensure the spots remain flat. If the Tough-Spots do not apply smoothly;
that is, if you observe bumps, bubbles, tears or curled edges, do not
attempt to smooth out the spot. Remove the spot and apply a new spot.
See Figure 5.2.

Figure 5.2
Applying Tough-Spots™ to the probe array cartridge

3.

Insert the cartridge into the scanner and test the autofocus to ensure the
Tough-Spots do not interfere with the focus. If you observe a focus error
message, remove the spot and apply a new spot. Ensure that the spots lie
flat.
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Scanning the Probe Array
Customers using the Autoloader should refer to the Autoloader User’s
Guide.
1.

2.

Select Run → Scanner from the menu bar. Alternatively, click the
Start Scan icon in the tool bar.
⇒ The Scanner dialog box appears with a drop-down list of all
unscanned experiments.
Select the experiment name that corresponds to the probe array you
wish to scan.
A previously run experiment can also be selected by using the Include
Scanned Experiments option box. After selecting this option,
previously scanned experiments appear in the drop-down list.
If you do not see your experiment name, open the workflow monitor,
right-click your experiment, and select Advance to Scan. Refer to the
GCOS manual for further information.

3.

Click the Load/Eject button and place the array in the scanner. Only
one scan is required for the GeneChip Scanner 3000.
Please do not attempt to manually open or close the GeneChip Scanner
3000 scanner door as you may damage the scanner.

4.

Once the experiment has been selected, click the Start button.
⇒ A dialog box prompts you to load the array into the scanner.

5.

Pixel resolution and wavelength for the GeneChip Scanner 3000 are
preset and cannot be changed.

6.

Open the sample door of the scanner and insert the probe array into the
holder. Do not force the probe array into the holder. The door of the
GeneChip Scanner 3000 closes automatically.
Do not force the probe array into the holder.

7.

Click OK in the Start Scanner dialog box.
⇒ The scanner begins scanning the probe array. When Scan in
Progress is selected from the View menu, the probe array image
appears on the screen as the scan progresses.
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Shutting Down the
Fluidics Station
1.

After removing a probe array from the probe array holder, the LCD
window displays the message ENGAGE WASHBLOCK.

2.

If you are using the FS-400, engage the wash block by pushing up on
the cartridge lever to the ENGAGE position.
If you are using the FS-450/250, gently lift up the cartridge lever to
engage, or close, the washblock.
⇒ The fluidics station automatically performs a Cleanout procedure.
The LCD window indicates the progress of the Cleanout procedure.

3.

When the fluidics station LCD window indicates REMOVE VIALS,
the Cleanout procedure is complete.

4.

Remove the sample microcentrifuge vial(s) from the sample holder(s).

5.

If no other processing is to be performed, place wash lines into a bottle
filled with deionized water.

6.

Choose Shutdown for all modules from the drop-down Protocol list in
the Fluidics Station dialog box. Click the Run button for all modules.
The Shutdown protocol is critical to instrument reliability. Refer to the
appropriate Fluidics Station User’s Guide for more information.

7.

After Shutdown protocol is complete, flip the ON/OFF switch of the
fluidics station to the OFF position.
To maintain the cleanliness of the fluidics station and obtain the highest
quality image and data possible, a weekly bleach protocol and a
monthly decontamination protocol are highly recommended. Please
refer to Chapter 6, Fluidics Station Maintenance Procedures.
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Customizing the Protocol
There may be times when the fluidics protocols need to be modified.
Modification of protocols must be done before downloading the protocol to
the fluidics station. Protocol changes will not affect runs in progress. For
more specific instructions, refer to the GeneChip Operating Software online
help.
1.

Select Tools → Edit Protocol from the menu bar.
⇒ The Edit Protocol dialog box appears.

2.

Select the protocol to be changed from the Protocol Name drop-down
list.
⇒ The name of the protocol is displayed in the Protocol Name box.
The conditions for that protocol are displayed on the right side of
the Edit Protocol dialog box.

3.

Select the item to be changed and input the new parameters as needed,
keeping the parameters within the ranges shown below in Table 5.7.

Table 5.7
Valid Ranges for Wash/Stain Parameters

Parameter

Valid Range

Wash Temperature for A1, B, A2, or A3 (°C)

15 to 50

Number of Wash Cycles for A1, B, A2, or A3

0 to 99

Mixes / Wash cycle for A1, B, A2, or A3

15 to 50

Stain Time (seconds)

0 to 86399

Stain Temperature (°C)

15 to 50

Holding Temperature (°C)

15 to 50

4.

To return to the default values for the protocol selected, click the
Defaults button.

5.

After all the protocol conditions are modified as desired, change the
name of the edited protocol in the Protocol Name box.
If the protocol is saved without entering a new Protocol Name, the
original protocol parameters will be overwritten.
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6.

Click Save, then close the dialog box.
Enter 0 (zero) for hybridization time if hybridization step is not
required. Likewise, enter 0 (zero) for the stain time if staining is not
required. Enter 0 (zero) for the number of wash cycles if a wash solution
is not required.
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Chapter 6

Fluidics Station Maintenance Procedures

Weekly Fluidics Station
Cleanout
A cleaning protocol is recommended for fluidics station maintenance if the
antibody staining procedure is used. Choose Bleach or Bleach_450 for all
modules from the drop-down list in the Fluidics Station dialog box. Click the
Run button for all modules and follow LCD instructions.
Bleach Protocol

This protocol is designed to eliminate any residual SAPE-antibody complex
that may be present in the fluidics station tubing and needles. We
recommend running this protocol at least once a week.
1.

Prepare 1 liter of 0.525% sodium hypochlorite solution using distilled
water. Shake well.
Each fluidics station with four modules requires at least 500 mL of the
0.525% sodium hypochlorite solution.

2.

Cut tubing.

Prepare Wash Tubing to the Appropriate Size

If you are using the Fluidics Station 450/250:
Cut three pieces of tubing with each piece at least 2.5-3 feet in length
(Tygon tubing, 0.04”) for each module of each fluidics station, for a
total of 6 tubes (for the FS-250) or 12 tubes (for the FS-450). These can
be reused for subsequent BLEACH runs.
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If you are using the Fluidics Station 400:
Cut four pieces of tubing at least 2.5 to 3 feet in length.
3.

Place all three wash lines (these are not the tubing on the needles but the
supply lines from the reagent bottles on the side of the station) of each
fluidics station in 1 liter of distilled water.
The BLEACH protocol requires at least 550 mL of distilled water.

4.

Choose Fluidics from the Run menu. Alternatively, click the down
arrow Protocol list on the toolbar.

5.

Choose Bleach or Bleach_450 for the respective modules in the
Protocol drop-down list.

6.

Disengage the washblock for each module by pressing down on the
cartridge lever.

Washblocks disengaged
with cartridge levers down
Figure 6.1
Disengaged washblocks showing cartridge levers in the down position.

Temperature will ramp up to 50°C.

GeneChip® Mapping 100K Assay Manual

7.

Connect tubing to needles.

If you are using the Fluidics Station 450/250:
Connect one end of the plastic tubing to each of the three needles. The
proper technique is to press down on the cartridge lever until the needles
extend a convenient distance from the module, then slip the tube on as
you hold the cartridge lever down with the free hand as shown in
Figure 6.2.
Take care not to bend or break the needles.

If you are using the Fluidics Station 400:
Connect one end of the plastic tubing to each needle at the bottom of
each module.

Figure 6.2
Inserting tubes on the needles. Take care not to break or bend the needles.
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8.

Insert the other ends into 0.525% sodium hypochlorite solution (at least
500 mL for all four modules) as shown in Figure 6.3.
Remove cartridges before you start the bleach protocol.

Figure 6.3
The tubes extending from the modules to the bleach bottle. Note that the probe array
cartridges must be removed before the protocol can begin.
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Ensure that all the tube ends remain immersed in the bleach solution by
tamping down on the tubes using a dowel or similar object as shown in
Figure 6.4.

Figure 6.4
Tamp down on the tubes to ensure that the ends remain immersed in the solution.

For ease of handling, band the tubes together using a rubber band.
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Remove any probe array cartridges and engage the washblock as shown
in Figure 6.5. The fluidics station will begin the protocol, begin to
empty the lines, and perform three cleaning cycles of 10 rinses each
using bleach solution.

9.

Figure 6.5
Remove probe array cartridges and pull up on the cartridge lever to engage the washblock and
begin the protocol.

10.

When the fluidics station LCD window displays Remove Tube from
Needles, carefully remove tubing from each module needle by pushing
the tubing down with your fingers while holding the needle with the
other.

Do not pull the tube out, as this may damage the needle in the process.
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11.

Load empty microcentrifuge vials onto each module.
The fluidics station will empty the lines and run three cycles with three
rinses each. In addition, the fluidics station will rinse the needle 20
times, twice using distilled water, then bring the temperature back to
25°C and drain the lines with air.

12.

The LCD display will read CLEANING DONE.
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Monthly Fluidics Station
Decontamination Protocol
To maintain your Fluidics Station in the best possible working condition, we
recommend that the following decontamination protocol be performed on
your fluidics station at least once a month, in addition to the weekly
cleaning described above. The protocol requires approximately 2 hours to
run.
This protocol ensures that all of the tubing associated with the station is kept
clean. Keeping this tubing as clean as possible ensures high-quality results.
1.

Prepare 2 liters of 0.525% sodium hypochlorite solution using distilled
water. Mix well.

2.

Place all three wash lines of the fluidics station in 1 liter of 0.525%
sodium hypochlorite solution.

3.

Run the Prime protocol (Fluidics Station 400) or the Prime_450
protocol (Fluidics Station 450/250) on all four modules with wash lines
in 0.525% sodium hypochlorite solution (instead of wash buffers A and
B).

4.

Run the Shutdown protocol (Fluidics Station 400) or the
Shutdown_450 (Fluidics Station 450/250) on all four modules with
wash lines in 0.525% sodium hypochlorite solution (instead of distilled
water).

5.

Follow Bleach Protocol (as described on page 81) with the following
change in Step 3: place the three wash lines of the fluidics station in 1
liter of 0.525% sodium hypochlorite solution instead of distilled water.

6.

Change intake tubing and peristaltic tubing, if required (as described in
the Fluidics Station 400 User’s Guide or the Fluidics Station 450/250
User’s Guide).

7.

Run the Bleach protocol (Fluidics Station 400) or the Bleach_450
protocol (Fluidics Station 450/250) with three wash lines of the fluidics
station in distilled water.

8.

Run the Prime protocol (Fluidics Station 400) or the Prime_450
protocol (Fluidics Station 450/250) with wash lines in distilled water
(instead of wash buffers A and B).

GeneChip® Mapping 100K Assay Manual

9.

Run the Shutdown protocol (Fluidics Station 400) or the
Shutdown_450 protocol (Fluidics Station 450/250) with wash lines in
distilled water.

10.

Run the Prime protocol (Fluidics Station 400) or the Prime_450
protocol (Fluidics Station 450/250) with wash lines in distilled water
(instead of wash buffers A and B).

11.

Run the Shutdown protocol (Fluidics Station 400) or the
Shutdown_450 protocol (Fluidics Station 450/250) with distilled water.

At the end of each step, the fluidics station will indicate a ‘ready’ status.
The fluidics station should not be used until this entire procedure (steps
1-11) is complete.
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Chapter 7

Analysis Workflow and Guidelines
for Assessing Data Quality

The purpose of this chapter is to outline the necessary steps to analyze
data following the scanning of GeneChip® Human Mapping 100K Set
(Mapping 50K Array Xba 240 and Mapping 50K Array Hind 240) and
to present some guidelines to assess the quality of the data. This
chapter is designed as a supplement to the information sources listed
below and does not replace them:
■

GeneChip Operating System (GCOS) User’s Guide

■

GeneChip DNA Analysis Software (GDAS) User’s Guide

Software Requirements
■

GeneChip Operating Software (GCOS) 1.2 or higher with GeneChip DNA
Analysis Software (GDAS) 3.0 or higher

■

GeneChip Operating Software (GCOS) 1.1.1 with Patch 5, or higher,
without GDAS 3.0. This configuration can be used for scanning only.

■

GeneChip Mapping 100K library files: Mapping 50K_Xba240 or Mapping
50K_Hind240

■

scannerUpdate.exe is a windows based application that must be run
once to configure the GeneChip Scanner 3000 to scan 50K arrays
The GeneChip Mapping 50K Array Xba 240 and the GeneChip Mapping
50K Array Hind 240 may be scanned with GCOS 1.1.1 with Patch 5.
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Analysis Workflow
This section describes the method for acquiring data using the GeneChip
Operating Software (GCOS) and then analyzing the data using GeneChip
DNA Analysis Software (GDAS). The outline of the data analysis workflow
is shown in Figure 7.1 and Figure 7.2.
If arrays are scanned using GCOS 1.1.1 with Patch 5, and then transferred to
a data analysis workstation using GCOS 1.2 and GDAS 3.0, refer to the
workflow diagram in Figure 7.2. The Data Transfer Tool imports data
generated with GCOS 1.1.1 with Patch 5 to GCOS 1.2. This must be
performed prior to analyzing data with GDAS 3.0.

Figure 7.1
Data analysis flow for GeneChip® Mapping 50K Arrays when using GCOS 1.2 and GDAS 3.0
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Figure 7.2
Data analysis flow for GeneChip® Mapping 50K Arrays when using GCOS 1.1.1 with Patch 5, Data Transfer Tool 1.0, and
GDAS 3.0.
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Analysis
The analysis of the data files takes place using GDAS 3.0 or higher. GDAS
3.0 can only be used in conjunction with GCOS 1.2 or higher. Note that
GCOS 1.2 or higher must be installed on the same workstation as GDAS 3.0
or higher. The following is an overview of the steps necessary to analyze
data using GDAS. Further information can be found in the GDAS 3.0
Software User’s Guide.
1.

Open the Batch Analysis window. Then, select the appropriate .cel files
and drag the files into the Batch Analysis window.
In order to analyze data with GDAS 3.0, .cel files that were generated
using GCOS 1.1.1 with Patch 5 must first be saved as a .cab file using the
Data Transfer Tool. Then, using the same tool, that data must be
transferred into GCOS 1.2. Refer to Figure 7.2 for an illustration of that
workflow.
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If no files can be seen in the file tree, check to see if any filters are
applied, this is shown by the “Filter Applied” message in the bottom
right of the window (Figure 7.3). The filter settings can be adjusted by
selecting the filter options in the Tools menu bar.

Figure 7.3
GDAS main window with the Batch Analysis window and Filters Applied message

2.

Click Analyze and the files will be analyzed.

3.

After Batch Analysis is complete a report will be displayed
summarizing data from the samples.
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Report

A Mapping Algorithm report is automatically generated when you analyze
cell intensity data from Mapping arrays. The report is automatically
displayed when you use the Batch Analysis window to analyze data.
The Mapping Algorithm Report has several important indicators that
must be checked for each array in order to assess the quality of the data
(see page 105).

Figure 7.4
Dynamic Model Mapping Algorithm report
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You can also open a Mapping Algorithm saved report by:
1.

Clicking the Open button in the main toolbar, or selecting File → Open
from the main menu.
⇒ The Open dialog box appears.

Figure 7.5
Open dialog box

2.

From the Data of Type drop-down list, select Reports (*.RPT).

3.

Select the Mapping Algorithm report from the displayed list.

4.

Click OK to open the report.

The report contains information that can be used to assess the performance
of the sample. Refer to Table 7.1 for the report components and description.
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Table 7.1
Dynamic Model Mapping Algorithm Report Components

Report Components

Description

Total number of SNPs

Number of SNPs on array.

Total number of QC Probes

Number of QC SNPs on array.

Probe array type

Affymetrix probe array model number.

SNP Performance

A list of the analyzed samples, with the following
information:

Sample

An identifier assigned to the analyzed samples.

Gender

Gender of the sample determined by the DM algorithm.

SNP Call Rate

Number of SNP calls/Total number of SNPs on the array.

AA Call Rate

The number of AA calls for the sample/Total number of
SNPs on the array.

AB Call Rate

The number of AB calls for the sample/Total number of
SNPs on the array.

BB Call Rate

The number of BB calls for the sample/Total number of
SNPs on the array.

QC Performance

A list of the analyzed samples, with the following
information:

Sample

An identifier assigned to the analyzed samples.

Median PM
(QC Probe Set ID)

Median Intensity Value for perfect match cells for the QC
probe sets.

MCR
(DM Mapping only)

MPAM Call Rate: The number of SNPs called with MPAM
algorithm/Total number of SNPs checked with the MPAM
algorithm for QC purposes.

MDR
(DM Mapping only)

MPAM Detection Rate: The number of SNPs passing the
MPAM discrimination filter/Total number of SNPs checked
with the MPAM algorithm for QC purposes.

Common SNP Patterns
(DM Mapping only)

Calls for a selected set of SNPs, displayed as a list of the
analyzed samples with the allele calls for the common
SNPs.

Output

Following analysis, .chp files are generated for each sample. The .chp files
can be opened by double-clicking on the files in the GDAS data file tree.
Multiple .chp files can be opened simultaneously. Once opened the .chp files
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will display a Dynamic Model (DM) scatter plot in the upper portion of the
window and a data table in the lower portion of the window as shown in
Figure 7.6. In the data table a genotype call for each SNP along with a
confidence score is displayed.

Figure 7.6
Dynamic Model Mapping Algorithm Table View

If you do not see the .chp files that you have generated in the data file
tree, right-click the “Analysis Results” bar and click “Refresh All,” or
make sure the Filter settings are set correctly.
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Additional Functionality

GDAS provides additional functionality including the ability to import
sample attributes, view raw probe intensity data, update SNP annotations
from the NetAffx Analysis Center, and export data.
Import Sample Attributes

Pedigree information associated with the sample can be imported into the
GCOS Process database by using the AttributeImporter Tool. Attributes can
be imported from multiple samples in batch from files or excel spreadsheets.
Attributes include information like father, mother, family and diseased state
and must be imported before checking Mendelian Inheritance or importing
into Merlin or GeneHunter.

Figure 7.7
GDAS AttributeImporter Tool
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Examining the Raw Probe Data

The raw probe intensity information can be obtained by selecting a SNP
identifier and clicking on the Probe Intensity option in the Run menu.
Select the appropriate .cel file and the probe intensity data will be displayed
in bar or line graph format.
Export

SNP call data can be exported for use in third party software products as
either a tab delimited file; in Merlin format, GeneHunter format, or
Microsoft Excel format. To export data:
1.

Open the .chp files you would like to export.

2.

Select Export and Table in the menu bar.

3.

Specify the location and format of the export data.
The data set displayed in the table is exported.

NetAffx™ SNP Annotation

The NetAffx™ Analysis Center provides regularly updated information
about the SNPs on the Mapping arrays. You can download the annotation
data from the NetAffx Analysis Center and display it in the SNP table of the
Dynamic Model Mapping Analysis window.
Default annotations (provided with the software) include:
■

The SNP Consortium (TSC) IDs

■

dbSNP Database IDs

■

Chromosome position of the SNP

■

Genetic map position of the SNP

You can also download additional annotations, including:
■

Flanking microsatellite markers

■

Nearest genes
Some annotations are provided by default. These annotations are
automatically installed on your computer and displayed when the
Mapping window opens.
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You should download updates frequently from the NetAffx Analysis
Center to ensure that you have the most up-to-date information.

The default NetAffx annotations are displayed automatically when you
display analysis results in the Mapping window.
You may need to initialize NetAffx access to obtain certain types of
annotations to download annotations in the future.
Detailed information for initializing the default settings, and
downloading and selecting the annotations can be found in the
“NetAffx Annotations” chapter in the GDAS 3.0 (or higher) Software
User’s Guide.

To use the NetAffx annotation option for the first time:
1.

Initialize the NetAffx default settings.

2.

Download the NetAffx annotations you wish to display.

3.

Select the NetAffx annotations to display.
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Assessing Data Quality
The purpose of this section is to help researchers establish guidelines for
evaluating results generated from Mapping experiments. The Mapping
Algorithm Report in GDAS 3.0 has a number of parameters that must be
checked for each array in order to assess the quality of the data, and to
identify outlier samples (Table 7.2). It is important to check these
parameters, and to create a running log for each project. The Reference
Genomic DNA 103, included in the GeneChip Mapping Assay Kits can
serve as a positive control to ensure that all steps of the assay are being
performed correctly.
Table 7.2
Dynamic Model Mapping Algorithm Report metrics

Metric

Description

Call Rate (SNP Call)

Good first pass evaluation. If greater than 95%, data
accuracy is good.

Reference Genomic DNA 103 Call rate

Process control to show that assay steps are being
performed correctly.

MDR – MCR

Difference can be used to identify sample
contamination.

Shared SNPs

Evaluate possible sample mix ups.

Oligonucleotide controls

Help evaluate hybridization, fluidics and scanning
steps.

Evaluation of a particular sample should be based on the examination of all
samples and array performance metrics.
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Call Rate

The Call Rate is displayed in the Dynamic Mapping Algorithm report
(Figure 7.8) in the SNP Call column. It is an indicator of overall
performance of the assay. A Call Rate in excess of 95% indicates all steps,
from DNA isolation to scanning, have worked well. An error in any of the
assay steps or low quality DNA sample may be reflected in a reduced call
rate. Data should not be automatically rejected, however, if the call rate is
below 95%. Rather, the lower call rate should serve as an indicator to
consider additional information before accepting the data for downstream
analysis. The degree to which the accuracy is compromised will depend on
the cause of the low call rate. Some of the factors that can lead to a reduced
Call Rate include:
■

Genomic DNA quality

■

Deviation from assay protocol

■

Contaminated DNA

The Reference Genomic DNA 103 is a positive process control that will give
call rates of ≥ 95% when the assay is performed correctly (see page 114).
You may also wish to consider reanalyzing the sample at the more stringent
confidence score of 0.05 (see page 115).
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Figure 7.8
Dynamic Model Mapping Algorithm report

Genomic DNA Quality
Genomic DNA should be prepared following the guidelines in Chapter 3 of
this manual; DNA prepared outside these guidelines (e.g., degraded DNA,
nicked DNA or DNA with inhibitors) may produce lower Call Rates without
necessarily reducing accuracy. A gel image of the DNA before restriction
digestion can be used to evaluate DNA quality. It is highly recommended if
an alternate genomic DNA preparation method is used, a small pilot
experiment should be conducted to evaluate reproducibility and accuracy of
genotype calls.
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Deviation from Assay Protocol
A problem in any step of the assay may lead to a decreased Call Rate. The
gel images produced before DNA digestion and before PCR cleanup, the
PCR yield after cleanup, and a the gel image after fragmentation can be used
to identify problematic steps. Consult Chapter 8, Troubleshooting for further
information.
At a minimum, a PCR negative control (water instead of DNA template)
should be incorporated into each group of samples processed. Figure 7.9
illustrates a typical negative PCR result on a gel image (Lanes E and F). The
lane in the gel should be clean. If a process negative control (negative
control from the beginning of the assay) is incorporated into the assay, a high
molecular weight band may be observed. This is an artifact of the ligation
reaction (Figure 7.9 Lanes C and D). The Reference Genomic DNA 103 is a
positive process control that will give call rates ≥ 95% when the assay is run
correctly (Figure 7.9 Lanes A and B) (see page 114).

Figure 7.9
Example gel image of a Process Positive Control (A+B), Process Negative Control (C+D), and a
PCR Negative Control (E+F)
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Contaminated Genomic DNA
If the genomic DNA sample is contaminated with other DNA, a decrease in
the Call Rate is observed (see page 110). Samples with a Call Rate below
95% due to mixing show a significant drop in accuracy. The MPAM
Detection Rate (MDR) and MPAM Call Rate (MCR) in the GDAS 3.0
Dynamic Model Mapping Array Report (Figure 7.8) are used to identify
potential sample contamination (see page 110). The results of a DNA mixing
experiment, illustrated in Figure 7.10 and Figure 7.11, show that as the
amount of contaminating DNA increases, the Call Rate, MCR and
Concordance with reference genotypes all decrease, while the MDR remains
unchanged.
If you suspect a sample has DNA contamination, you may want to consider
using a fresh sample of DNA, and/or testing it with microsatellite markers.

Figure 7.10
The effect of genomic DNA contamination on MPAM Detection Rate (MDR), Concordance Rate, and MPAM Call Rate
(MCR) (Xba).
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Figure 7.11
The effect of genomic DNA contamination on MPAM Detection Rate (MDR), Concordance Rate, and MPAM Call Rate
(MCR) (Hind).

MPAM SNPs for Detecting Sample Contamination

As illustrated above, monitoring sample contamination is a critical
component of sample processing in SNP genotyping. While detection of
mixed or contaminated samples is relatively straightforward with multiallelic markers such as microsatellite markers, it can be more of a challenge
for bi-allelic markers. The presence of contamination in a sample reduces
genotyping accuracy and therefore genetic power. Guidelines are described
in this manual that aid in reducing contamination (i.e., lab set-up) as well as
detecting contamination through gel electrophoresis (i.e., process negative
controls and PCR negative controls) and analysis metrics in GDAS. This
section provides a method for assessing contamination using the GDAS
Report metrics.
In a pure sample, the proportion of labeled DNA target for two alleles of any
SNP will typically be present at one of three allelic ratios, 100:0, 50:50 or
0:100. The models used to make genotype calls from probe hybridization
data apply this information to determine the genotype call for each SNP, and
assign a no call if the observed data fall too far from these predicted ratios. If
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a mixed or contaminated DNA sample is genotyped, the assumption of only
three possible allelic ratios will be violated for many SNPs, resulting in
lower Call Rates. However, whether or not the sample is contaminated, the
MPAM Detection Rate (MDR) will remain high as it is based only on the
extent to which PM probes are brighter than MM probes. Therefore, a
reduction in Call Rate accompanied by no decrease in MDR is a
characteristic indicator of sample contamination (Figure 7.10 and
Figure 7.11). Note that for low levels of contamination, the decreased Call
Rate is accompanied with only a minimal decrease in accuracy, whereas
more dramatic sample contamination can result in much lower Call Rates
and decreased accuracy.
Because of the importance of detecting mixed or contaminated samples,
GDAS 3.0 has implemented an additional algorithm to supplement the
Dynamic Model algorithm to help with sample contamination detection. The
MPAM calling algorithm, used to make genotype calls for the Mapping 10K
array, is employed in this analysis to make genotype calls on a subset of
~ 6,000 SNPs chosen for each of the Mapping 50K Xba 240 and 50K Hind
240 Arrays. These SNPs were chosen based upon the ability to be a suitable
detector of sample contamination across large data sets. Using this subset
also allows the software to quickly derive contamination metrics without the
additional computational burden of having to make an extra set of calls on
the entire array.
If you suspect a sample has DNA contamination, you may want to
consider testing it with microsatellite markers.

Oligonucleotide Controls

The oligonucleotide control reagent (GeneChip Mapping 50K Assay Kit
Box 3) in addition to oligonucleotide B2 contains 4 hybridization control
oligonucleotides. Each control oligonucleotide is present in the
hybridization mix at determined concentrations ranging from 0.033 pM to
1.0 pM. The signals generated from the control oligos are reported in the .rpt
files. The relative intensities for each oligonucleotide should correlate with
the respective spike concentration. The exact signal value reported for each
oligonucleotide is not significant, but each oligo should be detected and the
signals reported should be linear relative to the spike in controls. If they are
not detected or do not form a roughly linear response this may indicate a
problem in the washing and staining procedure. Chapter 8, Troubleshooting
for further information.
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Check Consistency Between Xba and Hind Arrays Using Shared SNP Patterns

The GeneChip Mapping 100K Set will be used for projects genotyping 100’s
to 1,000’s of samples over the two array set. To minimize the risk of sample
switches, thirty-one identical SNPs are shared between the Mapping 50K
Xba 240 and the Mapping 50K Hind 240 Arrays. These shared SNPs can be
used as controls to determine if a sample switch occurred. For example, if a
sample was processed and hybridized to both the Mapping 50K Xba 240 and
the Mapping 50K Hind 240 Arrays, a call will be generated for each of the
31 SNPs that will have the same pattern for both arrays. Therefore, if the
same SNPs are detected on both arrays, then the samples should be the same.
If the samples are switched, then a certain number of SNPs called will not
have the same genotype calls. The illustration on Figure 7.12 shows a
matched and unmatched sample. The matched sample makes identical calls
for SNPs 1 to 10 on both arrays. The unmatched sample has discordant
genotype calls for five SNPs (2, 3, 5, 8, and 10).
There is a chance that by random error a SNP may be called differently by
the same sample on both arrays. Switched samples between unrelated
individuals will have significantly more than 5 discordant genotypes.

Figure 7.12
SNPs Shared between Xba and Hind used to control for Sample Switching (10 out of 31 shown).
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B2 Oligo Performance

The B2 oligo is a component of the Oligo Control Reagent, 0100 (OCR). It
is spiked into each hybridization cocktail and is highlighted on the image by
the following:
■

The alternating pattern of intensities on the border

■

The checkerboard pattern at each corner (Figure 7.13) and throughout the
array

■

The array name, located in the upper-left or upper-middle of the array
(Figure 7.14)

Figure 7.13
Example of corner checkerboard pattern.

Figure 7.14
Array name.

B2 Oligo serves as a positive hybridization control and is used by the
software to place a grid over the image. Variation in B2 hybridization
intensities across the array is normal and does not indicate variation in
hybridization efficiency.
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Concordance with Reference Genotypes on Reference Genomic DNA 103

A simple test that can be used to determine if the assay is performing to
specifications is to measure the concordance between two samples. The
Reference Genomic DNA 103, included in the GeneChip Mapping 50K
Assay Kits, can be used for this purpose. The calls generated from the
reference DNA should be > 99% concordant with the reference calls. The
following method allows users to quickly assess the concordance of their
data with the reference calls.
1.

Open the reference Genotype calls in Microsoft Excel.
Sort the calls in ascending order on the SNP ID.

a.
2.

Copy and paste the calls from GDAS from the reference DNA and paste
into Microsoft Excel.

3.

Check that the SNP IDs match.

Table 7.3
Columns used to calculate concordance

Excel Column

4.

5.

Contents

A

Reference DNA SNP ID

B

Reference DNA call

C

Test DNA call

D

Concordance check

E

No call

F

Valid concordant SNP

Create column called “concordance check”. This column will contain a
1 if the two genotype calls match and a 0 if they do not.
a.

Enter the following formula “=IF(B2=C2,1,0)”.

b.

Auto fill down.

Create a second Column Called “No Call”. This column will contain
“TRUE” if either call column contains a “NC”.
a.

Enter the following formula “=OR(B2="NC",C2="NC")”.

b.

Auto fill the column down.
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6.

7.

8.

9.

Create a third column called “Valid Concordant SNP”. This column will
contain a “TRUE” if the SNP calls match and neither is a “NC”.
a.

Enter the following formula “=AND(D2=1,E2=FALSE).

b.

Auto fill down.

Count the number of SNPs that had a genotype call in both experiments.
a.

At the base of the “NO Call” column enter the following formula
“=COUNTIF(E2:E10044,"FALSE")”.

b.

Press return.

Count the number of SNPs that have a genotype call in both
experiments and are concordant.
a.

At the base of the “Valid Concordant SNP” column enter the
following formula “=COUNTIF(F2:F10044,"TRUE")”.

b.

Press return.

The Concordance rate can be calculated by dividing the value from step
8 by the value from step 7.
The concordance rate should always be greater than 99%. Reasons for a
decline in the concordance rate include:
■
■
■

Selecting the wrong data set to compare to the reference DNA.
Contamination at some step in the assay.
Poor sample preparation.

Downstream Analysis Considerations

Adjust Default Value to Increase or Decrease Accuracy and Call Rate
For many genotyping applications, loss of accuracy can result in a
significant decrease in genetic power. The Dynamic Model Mapping
Algorithm uses the Wilcoxon Signed Rank Test to assign a confidence score
measuring the reliability of a genotype call. It is possible to adjust the
confidence score to allow a trade off between call rate and genotyping
accuracy (see Appendix D in the GDAS 3.0 Software User’s Guide). We
have chosen a cut off of 0.25 as a default value because it gives the best
overall performance for accuracy and Call Rate. Samples with a Call Rate
below 95% should be evaluated further before the data is used in
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downstream analysis (see page 106). In cases where the call rate for a
sample is below 95%, you may with to consider re-analyzing the data at the
more stringent confidence score of 0.05, which will decrease the Call Rate
for the sample, but may increase the accuracy of the genotypes.
It is also possible to increase the call rate of a sample by adjusting the
confidence score to 0.4 or greater. The user will need to determine the
relative importance of accuracy and Call Rate for their downstream analysis
needs. Adjusting the confidence score to 0.4 or greater has the ability to
increase the call rate to > 99%. In cases where the assay was run correctly,
(e.g., call rate > 95% with 0.25 confidence score), changing the confidence
score to 0.4 can reduce the accuracy compared to 0.25, but is still estimated
to be > 99% overall, based on concordance with HapMap genotypes.
Data Clean Up
For many genotyping applications, loss of accuracy can result in a
significant decrease in genetic power. Genotyping errors can be caused by
SNPs that give systematic errors, or by sporadic errors that occur due to
stochastic, sample or experimental factors. SNPs that systematically give
errors (e.g., out of Hardy Weinberg equilibrium) have been removed through
a SNP selection process1. Overall the accuracy has been shown to be
> 99.6% on the Mapping 100K Array Set. Prior to downstream analysis, the
user should consider taking steps to identify and eliminate sporadic
genotype errors. Steps may include eliminating SNPs out of Hardy Weinberg
equilibrium in control samples from the population, or eliminating
genotypes showing Mendel inconsistency or unlikely genotypes. GDAS 3.0
has functionality to identify SNPs showing Mendelian errors in user defined
samples (see Chapter 8 in the GDAS 3.0 Software User’s Guide).

1. See SNP Selection Criteria for the GeneChip Human Mapping 10K Array Xba 131
Technical Note. A similar process was used for the Mapping 100K SNP selection.
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Chapter 8

Troubleshooting

Assay Recommendations
Genotyping applications require very high accuracy to achieve maximum
power. Therefore, great care should be taken to avoid possible sources of
cross contamination that would lead to genotyping errors. As with any assay
using PCR, the GeneChip® Mapping Assay has an inherent risk of
contamination with PCR product from previous reactions. In Chapter 2, we
recommend a workflow to minimize the risk of cross contamination during
the assay procedure. It is essential to adhere to workflow recommendations.
PCR reactions should only be carried out in the main laboratory and
personnel should not re-enter the Pre-PCR Clean and PCR staging areas
following potential exposure to PCR product without first showering and
changing into clean clothes.
It is essential to carefully read and follow the protocol as written. This assay
has been validated using the reagents and suppliers listed, substitution of
reagents and shortcuts are not recommended as they could result in
suboptimal results.
Additional recommendations are listed below:
1.

Think ahead to ensure that reagents and equipment you require,
including designated pipettes, are in the correct work location. This will
make workflow easier and prevent contamination risks.

2.

Check that your spectrophotometer is accurately calibrated and ensure
readings are in dynamic range (~ 0.2 to 0.8 OD). This will ensure you
use the correct amount of genomic DNA, necessary for fragmentation
reaction efficiency and identifying good PCR yields. Adding the same
amount of labeled target to the arrays will help obtain reproducible call
rates.
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3.

Pay particular attention to the storage and handling of reagents. This is
especially important for enzymes such as DNA Ligase and GeneChip
Fragmentation Reagent (DNase I) which are sensitive to temperatures
exceeding -20°C. To prevent loss of enzyme activity when the enzymes
are removed from the freezer use a bench top freeze block and return to
-20°C directly after use. Take care when pipetting enzymes stored in
glycerol, which is viscous. Do not store at -80°C.

4.

Fragmentation Reagent (DNAse I) activity can decline over time after
dilution on ice, and should be added to samples as quickly as possible.

5.

The use of master mixes prepared with a 5% excess ensures consistency
in reagent preparation by minimizing pipetting errors and reducing
handling time of temperature sensitive reagents. The success of this
assay depends on the accurate pipetting and subsequent thorough
mixing of small volumes of reagents.

6.

The PCR reaction for this assay has been validated using one of the
specified thermal cyclers. These thermal cyclers were chosen because of
their ramping times. Take care programming your thermal cycler and
use the thin walled reaction tubes recommended. Thicker walled tubes
may result in reduced PCR efficiency and lower yields.

7.

It is essential to run gels to monitor both the PCR reaction and the
fragmentation reaction.
For the PCR reaction, individual PCR products are run on a 2% agarose
gel – product (bands) should be visible in the 250 to 2000 bp size range.
See Figure 4.2 on page 41.
Following fragmentation, run samples on a 4% agarose gel. Successful
fragmentation is confirmed by the presence of a smear, shown in
Figure 4.3 on page 48.

8.

Run controls in parallel with each group of samples.
Substitute molecular biology grade water for DNA at the PCR step as a
negative control. The absence of bands on your PCR gel for this control
confirms no previously amplified PCR product has contaminated your
samples. The Reference Genomic DNA 103 is supplied as a positive
control in the assay kits. This is an effective troubleshooting tool
confirming all individual steps have been successful completed.
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9.

Oligonucleotide controls are included in the assay kit, these are added to
the target samples prior to hybridization and act to confirm successful
hybridization, washing, staining, and sensitivity of the array. The
oligonucleotide control reagents contain oligo B2 which is used for grid
alignment.

Important Differences Between GeneChip Mapping Arrays and
GeneChip Expression Arrays
10.

For laboratories that also run GeneChip Expression arrays it is
important to check the temperature setting on the hybridization oven –
for the GeneChip® Human Mapping 50K Array Xba 240 and the
GeneChip® Human Mapping 50K Array Hind 240, this should be set to
48°C. The temperature for hybridization on expression arrays is
45°C.

11.

Buffer B is different for the expression and DNA arrays. Using the MES
based buffer B from the Expression protocol will result in substantially
reduced call rates for the GeneChip Mapping 50K Arrays. Also, care
should be taken to ensure the fluidics station is properly maintained and
primed with the correct buffers prior to use.

12.

Both protocols use the same stain reagents for each staining step.
However, after the last wash the Mapping 100K Array is filled with
Array Holding Buffer.

13.

The arrays in the GeneChip Mapping 100K Set are scanned once at
570 nm on the GeneChip Scanner 3000 with the high resolution
scanning upgrade.
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Troubleshooting Guide for
the GeneChip Mapping
100K Assay
Problem

Likely Cause

Solution

Faint/absent bands on PCR gel
Both samples & positive
control affected.

Problem with master mixes or individual
reagents.

Ensure all reagents added to master mixes and
enzymes are stored at -20°C. Work quickly with
enzymes and return to -20°C directly after use
to prevent loss of activity.

Failed restriction digest.

Run gel to confirm restriction enzyme activity.

Failed adaptor ligation reaction.

Confirm enzyme activity.
Ligase buffer contains ATP and should be
defrosted/ held at 4°C. Mix ligase buffer
thoroughly before use to ensure precipitate is
re-suspended. Avoid multiple freeze-thaw
cycles.

Reduced adaptor ligation efficiency due to To prevent self-ligation of adaptor work rapidly
adaptor self-ligation, DNA re-ligation.
and add DNA ligase last.
Failed PCR reaction.

Check PCR reagents. Take care with preparation
of master mixes and ensure accurate pipetting
and thorough mixing.

Reduced PCR reaction yield – non optimal
PCR conditions.

Use a validated thermal cycler, check PCR
programs. Use recommended thin walled
reaction tubes.

Ligation mix not diluted prior to PCR
reaction.

Ligation mixture diluted 1:4 with molecular
grade to remove potential inhibitors and
maintain optimal pH and salt concentration.

Incorrect concentration of nucleotides.

Check dNTP stock concentration and vendor.

Used Xba adapter for Hind digest, or vice
versa.

Repeat Ligation step with correct adapters.
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Problem

Likely Cause
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Solution

Faint/absent bands on PCR gel (continued)
Samples affected (but positive
controls OK).

Non-optimal reaction conditions.

Use master mixes and include a positive control
to eliminate reagents and assay problems as
detailed above.

Insufficient starting material.

250 ng genomic DNA should be used. Confirm
concentration using calibrated
spectrophotometer.

Sample DNA contains enzymatic or
chemical inhibitors.

Ensure genomic DNA is purified and diluted in
Low EDTA (0.1mm) TE buffer.
Ethanol precipitate genomic DNA to remove
inhibitors.

Degraded sample DNA.

Confirm quality of genomic DNA sample.

Bright bands present in negative control on PCR gel
Contamination during assay is most likely
due to amplified PCR product from assays
run previously. Sample results prepared in
parallel are likely contaminated and
unreliable. Reagents and/or pipettors are
likely contaminated.

Ensure lab personnel strictly adhere to one way
workflow and refrain from entering Pre-PCR
clean area and PCR staging area after being in
the main laboratory areas.
Decontaminate Pre-PCR clean area and PCR
staging area including all equipment.
Use new reagents and new pipettors.

Sufficient PCR product is present but
spectrophotometer is out of calibration.

Calibrate spectrophotometer. Proceed with
assay.

PCR product is lost due to reduced
temperature.

All purification steps must be carried out at 25
to 35°C.

Pipetman used for quantitation not
calibrated.

Calibrate Pipetman. Proceed with assay.

Low PCR yield
Gel image shows PCR product
but following purification
spectrophotometer
measurements at 260nm
indicate low PCR yield.

Fragmented PCR product is not the correct size
PCR product is still visible in
250-2000 bp size region

Incomplete fragmentation due to
underestimated DNA concentration.

Ensure spectrophotometer is properly
calibrated so only 40 µg of DNA is added to the
fragmentation reaction.

Failed or incomplete fragmentation due to Check you have entered the correct activity of
reduced DNase activity.
DNase into the formula (page 46) for calculating
amount of DNase to add to fragmentation
reaction.
Ensure fragmentation reagent (DNase I) is kept
at -20°C. Do not reuse diluted working stock.
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Problem

Likely Cause

Solution

.CEL file can not be generated
GCOS 1.1.1 with Patch 5 is
unable to align grid.

Unable to place a grid on the .DAT file due
to the absence of B2 signal.

Hybridization controls including oligo B2 must
be added to hybridization cocktail for grid
alignment.

.CEL image is dim.

Insufficient signal intensity or staining
failure.

Make fresh stain buffers.

Incorrect wash buffers used on fluidics
station.

Prime the fluidics station with the correct
buffers prior to running the assay. Incorrect
wash buffers will disrupt hybridization of the
labeled, fragmented DNA.

Low SNP call rates
Gel images and
spectrophotometric
quantitation indicate
successful PCR reaction.

Over fragmentation of DNA sample due to Use correct concentration of Fragmentation
incorrect dilution of Fragmentation
Reagent (DNase I). Check U/µL on the label and
Reagent (DNase I) stock.
check dilution formula on page 46. Work quickly
and on ice, transfer reaction tubes to pre-heated
thermal cycler (37°C).

Extremely low call rate
Sample hybridization is absent
on .CEL and .DAT images but
B2 grid is bright.

Labeling reaction suboptimal.

Use a new vial of Terminal Dideoxy Transferase.
Verify the labeling reagents and repeat labeling.

Positive control has good call
rates but samples are lower
than expected.

Genomic DNA not optimal.

Ensure DNA samples are of high quality, use
positive control sample as a reference guide for
assay procedures. Prepare master mixes for
samples and controls.

MDR high, MCR low.

Mixed or contaminated genomic DNA
sample (page 109).

Use uncontaminated stock of DNA sample.

Low call rates < 20%

Mixed up Hind arrays and Xba sample, or
vice versa.

Do Xba and Hind work on separate days.
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Chapter 9

Reagents, Instruments & Supplies

This section describes the reagents, supplies and equipment required
to implement the GeneChip Mapping 100K Assay. The first section
below describes the Affymetrix GeneChip® Mapping 50K Assay Kits
for Xba (P/N 900520) and Hind (P/N 900521), which contains critical
reagents and reagent components specifically developed and/or
optimized for the GeneChip Mapping 100K Assay, and controls that
are integrated for use with the GeneChip® Mapping 100K Set. This
section also indicates the Affymetrix equipment – scanner, fluidic
station, hybridization oven - and GeneChip® Mapping 50K Array
required for this assay. The second section describes the reagents,
supplies and instruments that are required, but not supplied directly
by Affymetrix. The products and vendors listed in this section have
been tested at Affymetrix during the development of the product –
other products and vendors have not been verified at Affymetrix. In
some cases, we have seen lower performance when using nonrecommended vendors.
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Required Reagents and
Instruments
The following reagents and equipment are required to process the
GeneChip® Mapping 100K Set.
Reagents Supplied by Affymetrix

Affymetrix GeneChip® Mapping 50K Xba Assay Kit P/N 900520
This kit includes sufficient reagent for 30 arrays
Component

Volume

Concentration

Description

Adaptor, Xba

38 µL

5 µM

Two annealed oligonucleotides (see below*), 1
specific for ligation to Xba restriction site.

PCR Primer, 001

1125 µL

10 µM

PCR primer (see below*), to amplify ligated
genomic DNA

1

Reference Genomic DNA, 103

25 µL

50 ng/µL

Human genomic DNA (single source)

2

GeneChip Fragmentation Reagent

20 µL

See label on tube

DNase I enzyme, formulated to fragment
purified PCR amplicons

3

10X Fragmentation Buffer

225 µL

10X

Buffer for fragmentation reaction

3

GeneChip DNA Labeling Reagent
(7.5 mM)

60 µL

7.5 mM

Biotin-labeled reagent for end-labeling
fragmented PCR amplicons

3

Terminal Deoxynucleotidyl
Transferase

105 µL

30 U/µL

Enzyme used to end-label fragmented PCR
amplicons with the GeneChip DNA Labeling
Reagent (7.5 mM)

3

5X Terminal Deoxynucleotidyl
Transferase Buffer

420 µL

5X

Buffer for labeling reaction

3

Oligo Control Reagent, 0100
(OCR, 0100)

60 µL

See protocol
Chapter 4

Mixture of five biotin-labeled
oligonucleotides, which hybridize to control
regions (gridding controls and array controls)
on the GeneChip Mapping 50K Array.

3

* ‘Adaptor, Xba’
PCR Primer, 001 5' ATTATGAGCACGACAGACGCCTGATCT 3'
Adaptor Xba

3' AATACTCGTGCTGTCTGCGGACTAGAGATCT 5'

PCR Primer, 001 is available as an individual component (P/N 900534).

Box #
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Affymetrix GeneChip® Mapping 50K Hind III Assay Kit P/N 900521
This kit includes sufficient reagent for 30 arrays
Component

Volume

Concentration

Description

Adaptor, Hind III

38 µL

5 µM

Two annealed oligonucleotides (see below*), 1
specific for ligation to Hind III restriction site.

PCR Primer, 001

1125 µL

10 µM

PCR primer (see below*), to amplify ligated
genomic DNA

1

Reference Genomic DNA, 103

25 µL

50 ng/µL

Human genomic DNA (single source)

2

GeneChip Fragmentation Reagent

20 µL

See label on tube

DNase I enzyme, formulated to fragment
purified PCR amplicons

3

10X Fragmentation Buffer

225 µL

10X

Buffer for fragmentation reaction

3

GeneChip DNA Labeling Reagent
(7.5 mM)

60 µL

7.5 mM

Biotin-labeled reagent for end-labeling
fragmented PCR amplicons

3

Terminal Deoxynucleotidyl
Transferase

105 µL

30 U/µL

Enzyme used to end-label fragmented PCR
amplicons with the GeneChip DNA Labeling
Reagent (7.5 mM)

3

5X Terminal Deoxynucleotidyl
Transferase Buffer

420 µL

5X

Buffer for labeling reaction

3

Oligo Control Reagent, 0100
(OCR, 0100)

60 µL

See protocol
Chapter 4

Mixture of five biotin-labeled
oligonucleotides, which hybridize to control
regions (gridding controls and array controls)
on the GeneChip Mapping 50K Array.

3

* ‘Adaptor, Hind III’
PCR Primer, 001

5' ATTATGAGCACGACAGACGCCTGATCT 3'

Adaptor, Hind III

3' AATACTCGTGCTGTCTGCGGACTAGATGCAp 5'

PCR Primer, 001 is available as an individual component (P/N 900534).

Box #
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Equipment and Software Supplied by Affymetrix

Item

Part Number

GeneChip Fluidics Station 400 or GeneChip Fluidics Station 450/250*

900116 or 00-0079

GeneChip Hybridization Oven*

800139

GeneChip Scanner 3000 with high resolution scanning patch*

00-0074

Affymetrix GeneChip Operating Software version 1.1.1 with Patch 5*, or version 1.2*

690031

Affymetrix GeneChip DNA Analysis Software 3.0*

690030

GeneChip Human Mapping 50K Array Xba 240*

900517 or 900518

GeneChip Human Mapping 50K Array Hind 240*

900522 or 900523

Reagents, Equipment and Supplies Not Supplied by Affymetrix

Assay Step

Reagents

Genomic DNA
Preparation

■

Reduced EDTA TE Buffer (10 mM Tris HCl, 0.1mM EDTA, pH 8.0)
TEKnova P/N T0223

■

Reference Genomic DNA, 103 (50 ng/µL) Affymetrix*, available in
Box 2 of the GeneChip® Mapping 50K Assay Kit, P/N 900520 and
900521 for Xba and Hind kits, respectively

■

250 ng Genomic DNA working stock/array: [50 ng/µL]

■

Xba I (20,000 U/mL): New England Biolab (NEB); P/N R0145L (if
running Xba Array) also containing:

Restriction Enzyme
Digestion

■

■

NE Buffer 2: New England Biolab (NEB); (P/N B7002S to order
separately)

■

BSA (Bovine Serum Albumin): New England Biolab (NEB);
(P/N B9001S to order separately)

Equipment

■

Thermal Cycler

Hind III (20,000 U/mL): New England Biolab (NEB); P/N R0104L (if
running Hind Array) containing:
■

NE Buffer 2: New England Biolab (NEB); (P/N B7002S to order
separately)

■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

96-well plate: MJ Research; P/N MLP-9601; or Applied Biosystems;
P/N 403083

■

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

■

8-Tube Strips, thin-wall (0.2 mL): MJ Research, P/N TBS-0201; Strip of
8 caps: MJ Research, P/N TCS-0801

* Denotes critical reagents, equipment or supplies. Formulations or vendors not listed here have not been
tested and verified at Affymetrix. In some cases, lower performance has been demonstrated by reagents from
non-qualified vendors.
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Assay Step

Reagents

Ligation

■

T4 DNA Ligase: New England Biolab (NEB); P/N M0202L
containing:
■

PCR

■

Thermal Cycler

■

PCR Thermal

T4 DNA Ligase Buffer: New England Biolab (NEB); P/N B0202S

■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

Adaptor Xba (5 µM); Affymetrix; P/N 900410 (if running Xba Array) ;
available in the GeneChip® Mapping 50K Xba Assay Kit, P/N 900520

■

Adaptor Hind (5 µM): Affymetrix; P/N 900485 (if running Hind III Array)
available in the GeneChip® Mapping 50K Hind Assay Kit, P/N 900521

■

H2O (Molecular Biology Water): BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

Equipment

Cyclerb*
(Ramp speeds on
these models are
critical - assay
protocols have
been optimized
for these two
thermal cycler
models only):

dNTP (2.5 mM each): Takara; P/N 4030, Fisher Scientific;
P/N TAK 4030, or Invitrogen; P/N R72501a

■

PCR Primer, 001 (10 µM): Affymetrix; P/N 900409 (if running Xba
Array), available in the Xba GeneChip® Mapping 50K Xba Assay
Kit, P/N 900520

■

PCR Primer, 001 (10 µM): Affymetrix; P/N 900409 (if running Hind
III Array), available in the Hind III GeneChip® Mapping 50K Hind
Assay Kit, P/N 900521

■

Platinum Pfx DNA Polymerase (2.5 U/µL): Invitrogen Corporation,
P/N 11708-039 containing:
■

10X Pfx Amplification Buffer

■

10X PCRx Enhancer

■

50 mM MgSO4

■

2% TBE Gel: BMA Reliant precast (2% SeaKem Gold); P/N 54939

■

All Purpose Hi-Lo DNA Marker: Bionexus, Inc.; P/N BN2050, or
Direct Load Wide Range DNA Marker: Sigma; P/N D7058

■

Gel Loading Solution: Sigma; P/N G2526

■

PCR Tubes*: (must be compatible and qualified with MJ Research
Tetrad, or ABI GenAmp PCR System) For example:

■

■

Individual tubes: MJ Research; P/N TWI-0201

■

8-Tube Strips, thin-wall (0.2 mL): MJ Research, P/N TBS-0201; Strip
of 8 caps: MJ Research, P/N TCS-0801

MJ Tetrad
(PTC-225) 96
well block, or

■

ABI GeneAmp
PCR System
9700 - 96 well
block

■

gel apparatus

■

Jitterbug: Boekel
Scientific, model
130000

Plate: (must be compatible and qualified with MJ Research Tetrad, or
ABI GenAmp PCR System)
■

■

■

96-well plate: MJ Research; P/N MLP-9601

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

* Denotes critical reagents, equipment or supplies. Formulations or vendors not listed here have not been
tested and verified at Affymetrix. In some cases, lower performance has been demonstrated by reagents from
non-qualified vendors.
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Reagents, Equipment and Supplies Not Supplied by Affymetrix

Assay Step

Reagents

PCR Purification
and Elution

■

Manifold - QIAvac multiwell unit: QIAGEN P/N 9014579

■

MinElute 96 UF PCR Purification Kit: QIAGEN P/N 28051 (four
plates), or P/N 28053 (24 plates)

■

Buffer EB (1000 mL): QIAGEN P/N120002

■

Biomek Seal and Sample Aluminum Foil Lids: Beckman P/N 538619

Equipment
■

Vacuum Regulator
for use during the
PCR clean up
step. QIAGEN
Vacuum Regulator
(use with QIAvac
manifolds):
QIAGEN; P/N
19530*

* The QIAGEN protocol requires ~800mb vacuum. If your lab does not have an internally
regulated vacuum source, this vacuum regulator is strongly suggested
Fragmentation and
Labeling

■

GeneChip Fragmentation Reagent (DNase I): Affymetrix,
P/N 900131

■

10X Fragmentation Buffer: Affymetrix, P/N 900422

■

Molecular Biology Water: Bio Whittaker Molecular Applications/
Cambrex, P/N 51200

■

4% TBE Gel: BMA Reliant precast (4% NuSieve 3:1 Plus Agarose);
P/N 54929

■

All Purpose Hi-Lo DNA Marker: Bionexus, Inc.; 50 - 10000bp; P/N
BN2050

PCR Thermal
Cyclerb*
(Ramp speeds on
these models are
critical - assay
protocols have
been optimized
for these two
thermal cycler
models only):

■

Gel Loading Solution: Sigma; P/N G2526

■

■

96-well plate: MJ Research; P/N MLP-9601

■

96-well PLT. Clear Adhesive Films: Applied Biosystems; P/N 4306311

MJ Tetrad
(PTC-225) 96
well block, or

■

GeneChip DNA Labeling Reagent (7.5 mM): Affymetrix;
P/N 900484, available in the Xba and Hind III GeneChip® Mapping
50K Assay Kits, P/N 900520 and P/N 900521, respectively

■

ABI GeneAmp
PCR System
9700 - 96 well
block

■

Terminal Deoxynucleotidyl Transferase (30 U/µL): Affymetrix;
P/N 900426, available in the Xba and Hind III GeneChip® Mapping
50K Assay Kits, P/N 900520 and P/N 900521, respectively

■

5X Terminal Deoxynucleotidyl Transferase Buffer: Affymetrix;
P/N 900425, available in the Xba and Hind III GeneChip® Mapping
50K Assay Kits, P/N 900520 and P/N 900521, respectively

■

* Denotes critical reagents, equipment or supplies. Formulations or vendors not listed here have not been
tested and verified at Affymetrix. In some cases, lower performance has been demonstrated by reagents from
non-qualified vendors.
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Reagents, Equipment and Supplies Not Supplied by Affymetrix

Assay Step

Reagents

Target Hybridization

■

5M TMACL (Tetramethyl Ammonium Chloride): Sigma; P/N T3411

■

10% Tween-20: Pierce; P/N 28320 (Surfactamps); diluted to 3% in
molecular biology grade water

■

MES hydrate SigmaUltra: Sigma; P/N M5287

■

MES Sodium Salt: Sigma; P/N M5057

■

DMSO: Sigma; P/N D5879

■

0.5M EDTA: Ambion; P/N 9260G

■

Denhardt’s Solution: Sigma; P/N D2532

■

HSDNA (Herring Sperm DNA): Promega; P/N D1815

■

Human Cot-1: Invitrogen; P/N 15279-011

■

Oligo Control Reagent, 0100 (OCR, 0100): Affymetrix; P/N 900541,
available in the Xba and Hind III GeneChip® Mapping 50K Assay
Kits, P/N 900520 and P/N 900521, respectively

■

20X SSPE: BioWhittaker Molecular Applications/Cambrex;
P/N 51214

■

Denhardt’s Solution, 50X concentrate: Sigma; P/N D2532

■

10% Tween-20: Pierce; P/N 28320 (Surfactamps)

■

Molecular Biology Grade water: BioWhittaker Molecular Applications/
Cambrex; P/N 51200

■

SAPE (Streptavidin, R-phycoerythrin conjugate): Molecular
Probes; P/N S866, 1 mg/mL*

■

Ab (Biotinylated Anti-Streptividin): Vector; P/N BA-0500, 0.5mg;*
reconstitute according to product instructions

■

Distilled water, Invitrogen Life Technologies, P/N 15230147

■

Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL),
Invitrogen Life Technologies, P/N 15561-020

■

Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504
(or equivalent)

Wash and Staining

Scanning

Equipment
■

GeneChip
Hybridization
Oven

■

GeneChip Fluidics
Station 400 or
GeneChip Fluidics
Station 450/250

■

GeneChip
Scanner 3000

* Denotes critical reagents, equipment or supplies. Formulations or vendors not listed here have not been
tested and verified at Affymetrix. In some cases, lower performance has been demonstrated by reagents from
non-qualified vendors.
a. dNTPs from Invitrogen (P/N R72501) have been tested on a limited basis with similar results. You should test in your
own lab prior to full scale production.
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b. The PCR process is covered by patents owned by Roche Molecular Systems, Inc. and F. Hoffmann-LaRoche Ltd
(“Roche”). A license to use the PCR process for certain research and development activities accompanies the purchase of certain reagents from licensed suppliers when used in conjunction with an authorized thermal cycler. If you
are using an MJ Research thermal cycler, your thermal cycler may not be an authorized thermal cycler and it may be
necessary for you to obtain authorization from Roche or ABI (see PCR licensing information in the MJ Research User
Manual). For information about obtaining a license contact The Director of Licensing at Applied Biosystems, 850 Lincoln Center Drive, Foster City, CA 94404 or the Licensing Department, Roche Molecular Systems, Inc., 1145 Atlantic
Avenue, Alameda, CA 94501.

Supplier Contact List
Supplier

Web Site

Ambion

www.ambion.com

Applied Biosystems

home.appliedbiosystems.com

Bionexus Inc.

www.bionexus.net

Boekel Scientific

www.boekelsci.com/

Cambrex

www.cambrex.com

Fisher Scientific

www.fisherscientific.com/

Invitrogen Life Technologies

www.invitrogen.com

MJ Research

www.mjr.com

Molecular Probes

www.probes.com

New England Biolabs

www.neb.com

Operon Technologies

www.operon.com

PanVera

www.panvera.com

PerkinElmer Life Sciences

lifesciences.perkinelmer.com/

Pierce Chemical

www.piercenet.com

Promega

www.promega.com

QIAGEN

www.qiagen.com

Sigma-Aldrich

www.sigma-aldrich.com

TaKaRa Bio Inc.

www.takara-bio.co.jp/english/index.htm

TEKnova

www.teknova.com/

Vector Laboratories

www.vectorlabs.com

